IBM Infoprint

Using IBM Infoprint Scan

G544-5722-00

.||I



Note!
Before using this information and the product it supports, be sure to read the general information in "Notices' on
page v.

First Edition (October 1999)
This edition applies to IBM Infoprint Scan Version 3 Release 2 and applies to all subsequent
releases of this product until otherwise indicated in new releases or technical newsletters.

The following paragraph does not apply to the United Kingdom or any country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES
CORPORATION PROVIDES THIS MANUAL “AS IS” WITHOUT WARRANTY OF ANY KIND,
EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions. Therefore,
this may not apply to you.

IBM does not warrant that the contents of this publication will meet your requirements or that the
publication is error-free.

Requests for copies of this publication and for technical information about IBM ® products should
be made to your IBM Printing Systems Marketing Representative.

IBM Printing Systems welcomes your comments. You may send your comments to the following
address:

INFORMATION DEVELOPMENT
IBM PRINTING SYSTEMS
DEPARTMENT 588 BUILDING 003G
PO BOX 1900

BOULDER CO 80301-9191

If you prefer to send your comments electronically, use one of the following methods:
e Internet: printpub@us.ibm.com
e Fax: 1-800-524-1519

Internet: For the latest technical information about Infoprint Scan and related products, visit
http://www.ibm.com/printers_and select the appropriate Infoprint 2000 or Infoprint
Manager sitelet.

When you send information to IBM, you grant IBM a nonexclusive right to use or distribute the
information in any way it believes appropriate without incurring any obligation to you.

However, the following copyright notice protects this documentation under the Copyright laws of
the United States and other countries which prohibit such actions as, but not limited to, copying,
distributing, modifying, and making derivative works.

© Copyright International Business Machines Corporation 1999. All rights reserved.
US Government Users Restricted Rights — Use, duplication or disclosure restricted by GSA ADP
Schedule Contract with IBM Corp.

ii Using IBM Infoprint Scan



Contents

o) o = \'
=T [T . F= U4 € PP PPPN v
IBM INFOPIINt SCAN ......cccccceccceiiiiiciciseccceirieeesssssscecessreeessssssmasnssseeeasssssnmmmssenesasssasnmmnnsssesannssnnmnnnses 1
Creating a new Infoprint Scan document ..........ccccoccvmirinimrinner e 3
Scan a new INfoprint SCanN dOCUMENT ..........iiiiiiie et e e eee e e e 3
Build a new Infoprint Scan document with TIFF fileS.........ccoooiiiiiiiiiiiceee e 5
Setting UP the SCANNEY ..........ceeeeeeeeeeeeeeeeeeeeennenennnnnnnnnnnsnsssnsssnsssssssssssssssssssssssssnsssnsssnsnsssnsnsnsnsnnnnnnn 13
Viewing and modifying scanner SettiNgs............c.ueeiiiiiiiiiiiiiiiiiiee e 14
Understanding and using the available scanner settings.........cccovvvveeevviieieiieeieeieeeeeeeee, 15
Xerox Doculmage 620S scanner SEttiNgS ........uuvveeeiiecciiiiiiee et e e 16
Xerox Doculmage 620S advanced scanner SEtHiNgS .....oevvvvveveveeieiieiiiiiiiieeeeeeeeeeeeeeeeeeeeeeeee 19

L1 Lo] o) o L= 21
Example settings for scanning halftones............ceeiiiicciiiiie e 22
Enhancing images in an Infoprint Scan document............cccucoiiiicminisinssmnnsss s s 25
Enhance images when scanning @ NEW dOCUMENE...........ceeuuvuuieiieiieieiiieeeeeeee et e e e eeeeeeeenanns 25
Enhance images in a previously scanned doCUMENt...........cceeeiiiiiieiiiiiiiieeeeeeeeeeeeee e, 29
Selecting enhancemMeENt OPLIONS........eoeiiiiiiiiiieiiee et e e e e e e e taeeeeaaeeeeaans 31
Enhancement options and Settings ... 34
Printing Infoprint Scan doCumMEeNts...........cccciicmiiiiiiisissec e sse e e s s smss s e e s s s s ssmmmmnenes 39
Print Infoprint Scan documents on a locally attached printer ............ccocoieiiiiiiiiiieieeee, 39
Submit a print job to the INfoprint SEIVEr..........cccoeviiiiieee, 40
18] o] g1 T Lo = T o o TSR 41
Setting options for the Infoprint Scan document print job.......ccoovvveiieii, 42
Setting Print OPtiONS ... ..uviiiiiie it e e e e e e e e aaaas 42
Setting SCheAUIE OPTIONS.......eeiiieiiiiiiiieeeeeeeeeeeeeeeeee ettt e e e e e e e e e eeeeeeeeeeeeeeeeeees 43
Setting LayouUt OPIONS .....uuveiiieeie it ieiee ettt e e e e e e e e e e e e e st eeeeeaeeeennnrereeeaeas 44
SEtiNG PrEIEIENCES ... ...ttt e et e e e e e e e et e e e eaeeeeeansaeeeeaaaeaaanns 46
Setting Print PreferenCes ... 46
Setting Layout PreferEeNCeS ......c...uueiiiiiee et 47
Setting SChedule Pref@rENCES. ........uuveeeiieieieeeeeeeeeeeeeeeeee ettt e e e e e e ea e 48
Refreshing printing OptioNS ......coooeiiiiiii e 50
Checking print jOD StATUS.........oieee i 50
D] Eo VA A (== OO 51
(070l 0= TaTe =TT (o o 1= 51
Export an Infoprint Scan document as a PDF file........cccoovvviiiiiii, 52
L i 111U 54
Benefits of exporting a Scan document as a PDF file.......cccovvvveeiiiieiiiiiiiiiiiiiiiiiiiieieieeeeeee 54
Zoning pages in an Infoprint Scan documMeNt ........cccoccecerrerceccrresce e e e e 55
Ao 01 g To I 1 o= o [T U 56
Selecting scanner settings for ZONEd Ar€aS..........cciiiiiuuiiiiieeiieiiiiieee e e e 59
Viewing or modifying settings for a defined zone ... 60
Aligning pages in an Infoprint Scan document.........ccccccciiiiiiieeemeciiiireee e nea—. 63
L\ 1o 01T gTo I o Y=o =TSP PPUTR 63
Erasing areas from pages in an Infoprint Scan document ..........cccccevveceeerresceccrrencsceresseceeeas 67
ErASING e 68
Adding text and page numbers to pages in an Infoprint Scan document............................. 71
FaYe [0 [T Lo TR (=) S 71
Cae (o [aTo oY= To [T 01810 ] 1= =P PPPPPPFP 76

© Copyright IBM Corp. 1999 iii



Using Infoprint Scan cut, copy, and move funCtions ..........oeeeeeeeeememeeemee e 83
U et oot e et e e ettt eeeeeeseaaaaaaeteeetetesnnaneeeeeseesnnnntteetenetnnnnteeeeeserennnns 84
(070 ] o)V 87
/(0 A= T 90

Modifying layers with INfOPrint SCaN......ccccccccciiiiiiiieemeeiiir e e e s s asas e nmnas s re e e annnnases 95

Adding and replacing pages in an Infoprint Scan document............ccccceciicccemnniniccccscsnnceenns 99
Scanning to add Or replace PAGES .........coeevviiieeeiieeeeeeeeeeeeeeeeeeeeee e 99
INSErtiNG TIFF fil€S .....uueiiiiee i e e e e e e e e e e e 101
[atY=T g g To Tl o F=T g aq o F=Te [T 106

Removing or deleting Infoprint Scan documents and pages ........ccceeeeceeveeeceresceccer e 109
Remove or delete Infoprint Scan dOCUMENES........couuuuuuieeiiiiiiiieeeeeee e eee e e e e eeeaeees 109
Remove or delete pages from Infoprint Scan documents ............ccceeeeeeeeeeeeeeeeeec e, 110

REMOVE the CUIMENT PAGE ... oo it e e e ettt e e e e e e e e eeeba e seeeseeesannansas 110
Remove or delete SeleCted PAgES ... uu it 111

Hints and tips for using INfoprint SCaN .......cccciiiiiiiieeiiir e m e e nnans 113
Copy changes vS COPY DUTON ........ccueiii it 113
Scanning TWO-Sided OFiQINAIS.........ooieieeeee et e et e e e e e e e e e e e e e e saaeeeeennns 113
Selecting MUIIDIE fIlES .....iicueiii i 114
UsIiNg the Add Page lIST DOX .....uuueeiiiiieeeeite ettt e e e e e e e eeebeteeeeeaeeeeees 114
Navigating through an Infoprint Scan doCumMeNt..............coooeeeiiiiiiiiieeeee e, 115

Navigate through a document using View menu OptioNS .........eeieeiiiiieeveeiieeeeeeeeeeeeeeee e 115
Navigate through a document using the buttons in the tool bar..........ccccccceevvvveiiiiiiiiiennn.... 115
Zooming on pages in an Infoprint Scan doCUMENT ...........ceuuuuueieiiiiiiiieieee e eeeeees 115
Optimizing halftone scanning for printing as grayscale .........cccccccceeeeeeiiieeeeeeeeeeee, 116

Using the Infoprint Scan Copier interface ............ccciieeeeeeiiiiiiiieeeniiir s ssssseseereeeee 119

Starting the Infoprint Scan copier iINtErfaCe. .........ouuuiiiiiiiuiiiiee e 121
Starting the copier interface from the standard interface........cccccccevevevviveiiiiieieieiiieieeeeeee 121
Starting the copier interface first when Infoprint Scan is started............coccccueeeeeeeeennnnnee.... 122

SCaANNING AN PIINEING «..e oo e e e e et et e e e eaeeeeeea e seesaeessesannseesaeereesnnns 123
Scanning and printing @ SMall jOD ..........cooiiiuiiiiiiiiieeieeee e 124
Scanning and printing @ large jOD........couuuueiiiiiii e 125

Specifying Setup, Finish, and Enhance options ..........cccccccevvveii, 127

SPECITYING COPIET SELHINTS ..oeeveereieiiieiieietee et e e e e et e e e e e e e e eeabaeeseesseeesssanseeeeereensnnns 132

Changing the unit Of MEASUIE...........ccooeeiiiiiiiiieeeeeeeeeeeeeeeeeeeeeeeeeeeeeee e 136

Recovering from @ DAPEI JAIM . ....cuuuuee et ee ettt e e e e eeeeeeaaaasseeesereessanneseesseresssnnnseesanes 137

Using the VIEWPOIt DUTIONS.........cooeiiieieeeee et 138

1 Lo (= 139

iv Using IBM Infoprint Scan



Notices

References in this publication to products or services of IBM do not suggest or imply that IBM will
make them available in all countries where IBM does business or that only products or services of
IBM may be used. Noninfringing equivalents may be substituted, but the user must verify that
such substitutes, unless expressly designated by IBM, work correctly. No license, expressed or
implied, to patents or copyrights of IBM is granted by furnishing this document. You can send
license inquiries, in writing, to the IBM Director of Licensing, IBM Corporation, 500 Columbus
Avenue, Thornwood, NY 10594, USA.

Licensees of this program who wish to have information about it for the purpose of enabling: (1)
the exchange of information between independently created programs and other programs
(including this one) and (2) the mutual use of the information, which has been exchanged, should
contact: IBM Corporation, Printing Systems Legal Department, Mail Drop 001W, Boulder,
Colorado 80301 USA. Such information may be available, subject to appropriate terms and
conditions, including in some cases, payment of a fee.

Trademarks

IBM and Infoprint are registered trademarks or trademarks of IBM in the United States.

Windows is a trademark of Microsoft Corporation in the United States and/or other countries.
Other company, product and service names may be the trademarks or service marks of others.
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IBM Infoprint Scan

IBM Infoprint Scan is an application program you can use to scan hardcopy pages and assemble
the pages into documents that can be viewed, enhanced, and submitted for printing. Working with
scanned images can be a complex exercise. The quality of your output is determined on a job-by-
job basis, first by the quality of your hardcopy input, and then by how you manipulate the scanned
pages before printing. The following topics are provided to help you understand and carry out the

procedures necessary to achieve the best results when you use Infoprint Scan:

"Creating a new Infoprint Scan document” on page |3

"Setting up the scanner|' on page 13

"Enhancing images in an Infoprint Scan document” on page 25

"Printing Infoprint Scan documents" on page 139

"Zoning pages in an Infoprint Scan document’ on page 55

"Aligning pages in an Infoprint Scan document" on page 63

"Erasing areas from pages in an Infoprint Scan document" on page 67
"Adding text and page numbers to pages in an Infoprint Scan document" on page |71
"Resizing images in an Infoprint Scan document” on page|79

"Using Infoprint Scan cut, copy, and move functions|' on page|83
"Modifying layers with Infoprint Scan’ on page 95

"Adding and replacing pages in an Infoprint Scan document" on page 99
"Removing or deleting Infoprint Scan documents and pages'' on page 109
"Hints and tips for using Infoprint Scan" on page 113

"Using the Infoprint Scan Copier interface! on page (119

Notes:

Detailed information about using additional functions of Infoprint Scan can be found in the

online help that is provided with the program.
For you to carry out these procedures, it is assumed that:
— You have general knowledge of computers.

— IBM Infoprint Scan 2000 is installed.
or

IBM Infoprint Manager and IBM Infoprint Scan version 3.2 are installed and configured to

communicate with the Infoprint server.
— A scanner is attached to the workstation on which Infoprint Scan is installed.
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Creating a new Infoprint Scan document

The following procedures are applicable only when you are using the Infoprint Scan standard
interface. If it is available with your version of Infoprint Scan and you want to use the alternate
copier interface, refer to "Using the Infoprint Scan Copier interface! on page 119|for information.

You can create a new Infoprint Scan document by using the program and an attached scanner to
scan hardcopy original pages, by building a new document from existing TIFF (Tagged Image
File Format) files, or a combination of both.

Information is provided in the following topics:
e "Scan a new Infoprint Scan document” on page 3
e "Build a new Infoprint Scan document with TIFF files" on page 5

Scan a new Infoprint Scan document

Important!
e If you are using Infoprint Scan as a stand-alone application, begin with step 1.

o If Infoprint Manager is installed, and you have invoked Infoprint Scan from within the
Infoprint Submit program, place your original hardcopy document in the scanner's
document feeder, skip steps 1 through 4, and begin with step 5.

To scan and create a new document:

1. Open Infoprint Scan and place your original hardcopy document in the scanner's document
feeder. For the Xerox Doculmage 620S scanner, position the pages face up, inserting the
sheets with the short edges leading. For other scanners, refer to the manufacturer's
instructions.

2. Click File in the menu bar and then click New Document....

Optionz  Help

Mew Document... o Crl+M
Open... A

E xit

3. Inthe Create New dialog box:
a. Select the directory into which you want to save the scanned document.
b. Type a name for the Infoprint Scan document in the File name field. This name will also
be used for the name of the job ticket when you submit the document for printing.
c. Inthe Save as type field, be sure Job Ticket Files (*.jtk) is selected.

Create New
Save in: I-@ ScanJobs j gl I-EE_
B Exarnplel jtk
File name: IScanDoc. k. I Save i
Save az type: IJob Ticket Files [*jtk) ﬂ Cancel |
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4. Click the Save button.
Click File in the menu bar and then click Scan....
XN Edit Page Y“iew T

[HEw (7
e [t =l
Claze

LA
Bemove...
Expart...
Submit Job... Chl+l
Frirt.... Chrl+F
Exit

6. Inthe Original area of the Infoprint Scan document dialog box, select:
e One-sided if the original hardcopy document is printed on just the front side of the paper.

e Two-sided if the original hardcopy document is printed on both the front and back sides
of the paper.

(See "Scanning Two-Sided Originals| on page 113 for additional information about
scanning two-sided documents.)

Scan Document |

= TwoSided  Change Settings |

— Original

[T Landscape

b ode; Black and“white
Resalition ;600 dpi
Original Size : Letter - 8.5 % 11 in

[T Custom Page size I " I inches

— Location

& Append to end of curent document

Scan Cloze Help
L3

7. Check the Landscape check box only if you want to rotate the output image 90 degrees
clockwise.

8. Click the Change Settings button to view or change the scanner settings.
(Refer to "Setting up the scanner’ on page (13 for detailed information about scanner
settings.)
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9. If your original hardcopy document has a page size that is not listed among the scanner
settings options, check the Custom Page size check box and enter the dimensions in the
fields provided.

10. Click the Scan button.

11. When scanning has completed, the Append Scan Document dialog box will open. If you want
to scan more pages to add to specified locations in the new document, place your hardcopy
originals on the scanner, and repeat these instructions, beginning with step 5.

Append Scan Document |

= TwoSided  Change Settings |

— Oniginal

[ Landscape

fode; Black and“white
Reszalution :  B00 dpi
Original Size : | etter - 8.5 % 11 in

[T Custom Page size I " I inches

— Location

% append to end of curent docurment
™ |nzert before cument page
i~ Ingert after curent page

" Feplace curent page

Scan I Cloze L\\(J

12. Click the Close button in the Append Scan Document dialog box to return to the new, open
document.

13. If you also want to add one or more existing TIFF files to the new document, go to step|4/on
page 6/of the "Build a new Infoprint Scan document with TIFF files'" topic for information.

14. When you are finished with this document:
e Click File in the menu bar, and then click Close to close and save the document.
or
e (Click File in the menu bar, and then click Exit to close and save the document and exit
the Infoprint Scan application.

Build a new Infoprint Scan document with TIFF files

You can also build a new Infoprint Scan document without using a scanner at all. Use the
following procedure to use TIFF files that were previously scanned using Infoprint Scan or TIFF
files that were created with programs other than Infoprint Scan. You can add existing TIFF files
selectively, or you can add all of the files contained in a particular directory.

Note: If any of the files that you want to insert are read-only, keep in mind that you will not be
able to use any Infoprint Scan functions that would result in a modification to the read-
only files (such as, image enhancement, page alignment, adding text, or any other
editing). If you need to use these functions on the files or on the Infoprint Scan document

© Copyright IBM Corp. 1999 5



that will include the files, first change the files to read/write, or create and insert read/write
copies of the original files.

Important!

If you are using Infoprint Scan as a stand-alone application, begin with step 1.

If Infoprint Manager is installed, and you have invoked Infoprint Scan from within the
Infoprint Submit program, skip steps 1 through 4, and begin with step 5.

To use TIFF files to build a new Infoprint Scan document:

1.
2.

Open Infoprint Scan.
Click File in the menu bar and then click New Document....

Optionz  Help

MNews Docurment. . Chil+
Opeh... k

Exit

In the Create New dialog box:
a. Select the directory into which you want to save the scanned document.

b. Type a name for the Infoprint Scan document in the File name field. This name will also
be used for the name of the job ticket when you submit the document for printing.

c. Inthe Save as type field, be sure Job Ticket Files (*.jtk) is selected.

Create Hew E |

Save i I £ Scan Jobs

m Examplel . jtk

File name: IScanDDc.itk T
Save as type: IJDb Ticket Files [7.jtk] j Cancel |

Click the Save button.
Click Page in the menu bar, and then click Add....

(LN Wiew  Tools

"
Save Az

Delete
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6. To add one or more files selectively:
a. Click the Add File button in the File Selection area of the Add Page dialog box.

Add Page E

— Location
" Append to end of cunent document
" Insert before curent page
' Replace cument page

 File Selection

Add Directony...

&dd File.

Femoye

Inzert Blank

1 b

[Vame | Cancel | Help |

b. Inthe Open TIFF Files dialog box, locate the appropriate directory and highlight the file(s)

you want to insert.
(See "Selecting multiple files!' on page 114/for information about selecting multiple files.)

Open TIFF File 2 x|
Lok, jr: Ia Scan shulf j gl E
1 tester_1_0005.kf [ testit_1_000S.tf [ ZoreSamp_1_000ZtF |
[# tester_1_000G.Af [ testsize_1_000T.H [ ZoneSamp_1_00034F |
[ tester_1_0008.tF Mo testsize_1_DO0ZHF [ ZoreSamp_1_0004.tF |
£ testit_1_0001.HF M Unttled_1_0001.6F [ ZoreSamp_1_0005t [
[# testit_1_0003 4 [ untiled_1_000360 [ ZoneSamp_1_0006.tF |
[ testit_1_000A L M ZoreSamp_1_0001.tF [ ZoreSamp_1_0007.tF [
Kl | L
File name: "testit_1_00070 tf" “tester_1_0005 " Open
Files of type: [ TIFF files(= it~ tff) = Cancel

c. Click the Open button.
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The highlighted file(s) will be added to the list box in the Add Page dialog box.
(See "Using the Add Page list box|' on page [114for information about using the list box.)

C:A\ScanhScan stuffstestit_1_0007 ki
CAScan\Scan stuffstester_1_0005 b
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7. To add all of the files in a directory:
a. Click the Add Directory button in the File Selection area of the Add Page dialog box.

Add Page | |
— Location

" Append to end of current document

€~ |nzert before cunent page

" Replace curent page

 File Selection

Add Directony,

Add File...

< i

Eremowve

Inzert Blank

gl

[Mome | Carcel | Help

b. Inthe Open directory to add files dialog box, select the directory that contains the files
you want to insert.

Dpen directory to add files

Loak jn;

Caricel

c. Click the Open button.

The files contained in the highlighted directory will be added to the list box in the Add
Page dialog box. If necessary, you can reorder the files or selectively remove individual
files from the list. (See "Using the Add Page list box! on page [114/for information about
using the list box.)

© Copyright IBM Corp. 1999 9



8.

10

In the Add Page dialog box, select one of the following:

Append to end of current document - to add the TIFF file(s) at the end of the
document that is currently displayed. The last added file will become the last page of the
document. Multiple files will be processed in the order in which they appear in the list box,
that is, from the top down.

Insert before current page - to add the TIFF file(s) in front of the page that is currently
displayed. Multiple files in the list box will be processed in reverse order, so that the files
are added one in front of the other, from the bottom of the list to the top of the list.

Insert after current page - to add the TIFF file(s) in back of the page that is currently
displayed. Multiple files will be processed in the order in which they appear in the list box,
that is, from the top down.

Replace current page - to insert the TIFF file(s) at the same location in the document as
the page that is currently displayed, and delete the current page. For multiple files, the
first file in the list will replace the current page and any subsequent files in the list will
then be inserted after the current page.

Add Page

— Location

€ Append to end of current document
" Ingert before cument page
& Ingert after current page

' Replace curent page

— File Selection

C:A\Scan\Scan stuffsnesttest_1_0031 d Add Directany...
CAScan\Scan stuffstester_1_0007 b
CAScan\Scan stuffstester_1_0002 b
C:A\Scan\Scan stuffstester_1_0003 tF
CAScan\Scan stuffstester_1_0004. v
C:\Scan\Scan stuffstester_1_0005 ki
CAScan\Scan stuffstester_1_000E v
C:\Scan\Scan stuffstester_1_0008 ki
C:AScanhScan stuffstestit_1_0007 Hf
CAScanhScan stuffstestit_1_0003.kf
C:A\ScanhScan stuffstestit_1_0004.tf
CAScanhScan stuffstestit_1_0005 L
C:\Scan\Scan stuffstestzize 10007

CAScanhScan stuffstestzize 1_0002
C:ASearhSean stuffwuntiled_1_0003 tf w|  InsertBlank |

Add File...

b i

Dane [}J Cancel | Help |

Notes:

e The first time you add pages to a new document, it doesn't really matter which option
is selected. Once the first page or pages have been added, you need to remember to
select the appropriate location when you add additional pages.

e When you use the Insert before current page, Insert after current page, and
Replace current page options, keep in mind that when you insert a page, the new
page becomes the current page. If you add additional pages, depending on which
option you select, the next page scanned will be inserted before, after, or will replace
the last page scanned.
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9. Inthe Add Page dialog box, click the Done button to add the listed files and return to the
open document, where the newly added pages will be displayed.

You can now use image enhancement and other editing functions on the pages in the new
document, with the exception of any read-only files you may have inserted. (See the Note on
page 5 /for additional information.)

10. When you have finished with the open document:
e Click File in the menu bar, and then click Close to close and save the open document.
or
e (Click File in the menu bar, and then click Exit to close and save the document and exit
the Infoprint Scan program.

© Copyright IBM Corp. 1999 11



12

Using IBM Infoprint Scan



Setting up the scanner

There are no certain scanner settings that will guarantee the best quality output from your
hardcopy original documents. You determine the settings you need for the best quality output on
a job-by-job basis by estimating the quality of your input, and then by how the output appears on
observation. The information in this section will explain your options to help you determine what
settings you should use.

Before you attempt to use your scanner with Infoprint Scan:
e Be sure you have installed the scanner driver software.

e The scanner must be powered on before your computer is powered on, or the SCSI
controller will not detect the scanner. If the scanner was not active when you last started
your computer, shutdown the computer, power on the scanner, and then restart the
computer.

e Start Infoprint Scan, then:
1. Click Options in the menu bar and then click Select Scanner...

Optione WalE

Enhance Settings ...
Scanner Seftings. ..
Server Settings...
Frint Job Status
Preferences. ..
Refrezh
Background Colar. .

Select Scanner...

2. Inthe Scanner Selections dialog box:
e Highlight the name and type of scanner you are using.
e Click the OK button.

Scanner Selection

Scanner: 0K
Fujitzu M 30966 [extended resolutionsz) ﬂ
Fuiitzu M309700G Cancel

Fujitzu bME303700G [extended resolutions)
Fuijitzu K 309705

Fuiitzu M3097G [extended resalutions)
Fuijitzu M3132E

Fuiitzu ScanPartner E.0.
ey Doculmane 6215

Setup...

Filters,..

i
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Viewing and modifying scanner settings

Every scanner is different and has its own settings that control how pages are to be scanned.
Infoprint Scan supports the industry standard ISIS scanner drivers that are provided by the
scanner manufacturers. These drivers provide default scanner settings based on standard types
of hardcopy originals. You can use the default settings or you can modify the settings as
necessary to get the best quality output.
To view or modify scanner settings:
1. Access the Scanner Settings dialog box:

a. Open a new or an existing document.

b. Click Options in the menu bar and then click Scanner Settings....

Options WEE

Enhance Settings ...

Scanner Settings. .

Server Settings...
Print Job Status
Freferences...
Refresh
Background Calor....
Select Scanrer...

or

When you are in the process of scanning a new document or adding pages to an existing
document:
e Click File in the menu bar, and then click Scan....

XN Edit Page “iew T

[HEw.. [Etr
Eem.. [t =
Cloze

h
Bemove...
Expart...
Submit Job... Chl+l
Brint... Clrl+F
E xit
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e Click the Change Settings button in the Scan Document or Append Scan Document
dialog box.

Append S5can Document |

— Original
' DOne-Sided

[T Landscape

b ode; Black and“white
Resalition ;600 dpi
Original Size : Letter - 8.5 % 11 in

[T Custom Page size I " I inches

— Location

& Append to end of curent document
i~ Ingert befare cument page
™ Inzert after current page

" Feplace curent page

Scan I Cloze | Help I

In the Scanner Settings dialog box:
a. Modify the settings as appropriate, or use the default settings.
b. To view or modify additional, advanced settings, click the More... button.

c. Modify the advanced settings as appropriate (or use the default settings), then click the
OK button.

d. When you are done, click the OK button in the Scanner Settings dialog box.

Understanding and using the available scanner settings

Explanations of the settings that can be specified for the Xerox Doculmage 620S scanner are
provided in:

"Xerox Doculmage 620S scanner settings' on page 16

"Xerox Doculmage 620S advanced scanner settings|' on page 19
Some examples are provided in "Example settings for scanning halftones/' on page 22.
Additional information about using the Xerox Doculmage 620S scanner, and working with
scanned images can be found in the documentation provided with the scanner.

For information about the settings that can be specified for any other scanner, refer to the
documentation provided by the manufacturer of your scanner.
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Xerox Doculmage 620S scanner settings

You can specify values for the following settings in the Scanner Settings dialog box for the Xerox
Doculmage 620S scanner:

e Mode - use this to select the type of output you want after scanning. Choices include:

Scanner Settings

Mode:

Black and White

i
256-Level Gray

— Black and White - convert scanned images to black and white.
— 256-Level Gray - keep scanned images as grayscale.

o Dither - (Available only when Black and White Mode is selected.) use this to select the
image type that will determine how your input document is processed. Choices include:

Scanner Settings

Mode:
[Black and White =
Dither:
Hone
Text and Line Art

Photograph

Fine Halftone

Coarse Halftone k

Fill -
Auto Segmentation i

[l

— None - use the default, no specified processing.

— Text and Line Art - use this when the hardcopy original document consists primarily of
text and artwork composed of solid lines.

— Photograph - use this when the hardcopy original is a photographic, or continuous tone
document consisting of different shades of gray and gradation of tones. A photographic
document is translated into a halftone image when it is scanned. In most cases, a fine
halftone with a resolution of 150 dpi (dots per inch) or greater can be treated as a
photograph.

— Fine Halftone - use this when the hardcopy original is a reproduction of a photograph
consisting of very small and clearly defined dots. A fine halftone image was originally a
continuous tone, photographic image that was produced by applying a halftone screen
with a frequency of 106 dpi or greater. A fine halftone with 150 dpi or greater can usually
be treated as a photograph. When you select this image type, the scanner attempts to
remove the original fine halftone and replace it with a coarse halftone in which dark areas
are represented by large black dots, and light areas are represented by smaller black
dots. A magazine photograph is an example of a fine halftone.

— Coarse Halftone - use this when the hardcopy original is a reproduction of a photograph
that consists of larger and more clearly defined dots used to represent a range of tones.
Coarse halftones generally have a screen frequency of 105 dpi or less. These documents
generally have large areas of continuous tone with few details. A newspaper picture is an
example of a coarse halftone.

— Fill - use this option to replace the entire image, or a specified (zoned) area of your
image, with solid black or white or with a fill pattern. After you select this option, click the
More... button, to access the Image Quality dialog box where you can further define the
fill pattern and shading.

°  For more information about defining the fill, go to "Fill options" on page 21|
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For more information about zoning, refer to "Zoning pages in an Infoprint Scan
document/' on page 55!

— Auto Segmentation - use this when the hardcopy original is a combination of text and/or
line art and continuous tone or halftones. The scanner will automatically identify and
process areas of the image according to their composition.

o Dots per inch - use this to specify the resolution at which you want to scan the document.
The higher the scan resolution you set, the finer the detail, but be aware that a high resolution
image requires much more memory space and processing time than a low resolution image.
You will generally get high quality results if the scanning resolution is set as close as possible
to the resolution of your output device. A lower resolution will result in lower quality, and a
higher resolution is a waste of memory.

Scanner Settings

Mode:
[Black and White =
Dither:

| Fine Halftone ﬂl
Dots per inch:

iod 7]
200

300
400

1200 g

o Page size - use this to specify the paper size of the hardcopy original.

Mode:

[Black and white =
Dither:

|Fine Halftone jl
Dots per inch:

s =]
Page Size:

Letter - 85 x 11 in hd
Scanner's Maximum -

55x85in —

Letter - 8.5 x 11 .1n
Letter - 11 x 8.5 in
Legal - 8.5x14 in
11 x15in x

Note: If the size of your paper is not listed, and you need to define a custom paper size,
you can do so in the Scan Document or Append Scan Document dialog box when
you are scanning to create a new document or to append an existing document.
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Brightness - use this to adjust the darkness control on the scanner. A high setting on the
slide bar results in a lighter overall image, and a low setting results in a darker overall image.
When you scan a dark image, the darker areas may appear as deep black, even though they
contain gray shades. Increasing the setting will cause the shades of gray to appear.
Conversely, if a light image appears too white, decrease the setting. Use the Darken, Norm,
and Lighten buttons to adjust a light, normal, or dark image overall.

Scanner Settings

Mode: Brightneszsz

| Black and White j| & Manual {T Automatic

Dither: [ o _’*D &

| Fine Halftone j| i

Dotz per inch: Darken I Horm I Lighten I
|400 =]

Contrast - use this to control the difference between the light areas and the dark areas of an
image. A high setting on the slide bar emphasizes black and white, leaving few middle gray
shades; a low setting emphasizes the middle gray shades, at the expense of black and white.

Scanner Settings

Mode: — Brightness

| Black and White jl " Manual ¥ Automatic
Dither: | KN | *Os

| Fine Halftone ﬂl :

Dots per inch: Darken I MHorm I Lighten
[0 ]

Page Size: — Contrast
RN - | & Manual & Automatic
PIXDFLT ¥ersion 51.202 | R ol _»E%E [
DOCUB20S Version 1.63

Region Selection - when scanning duplex, use this to specify the side(s) of the sheet of
paper to which you want to apply the settings. Only the following options apply when using
the Xerox Doculmage 620S scanner driver with Infoprint Scan:

— Both Main Scans - apply settings when scanning both the front and back of the sheet.
— Front Main Scan - apply settings when scanning just the front of the sheet.

— Back Main Scan - apply settings when scanning just the back of the sheet.

Mode: — Brightne:
|Black and white j| ¥ Manu
Dither: [N
|Nune j|

Dots per inch: %
oo 5

Page Size: — Contrast
|Letter -85x11in j| & Manu
PIXDFLT ¥ersion 51.202 e
DOCUB20S Version 1.63

Region Selection
Region: Both Main Scans J
T

Front Main Scan
Back Main Scan
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Note: After you have selected your options in the Scanner Settings dialog box, click the More...
button to view and modify additional, advanced settings.

Scanner Sethings
Mode: — Brightness | oK I
| Black and White ﬂ| ¥ Manual T Automatic
Dither: [N o Nimk: Default |
[Fctiatione___ 1| _ Cancel |
Dots per inch- Darken | MHorm I Lighten |
&0 =]

Page Size: — Contrast More... % |
| Letter - 85 x 11 in j| % Manual  Automatic
PIXDFLT Version 51.202 KD 2 sl 6 .
DOCUG205 Yersion 1.63 Hilters. . |
Region Selection Additional Regions:
Region: |Bnth Main Scans j| Front: EI Back: EI

For information about the additional settings, go to "Xerox Doculmage 620S advanced scanner
settings!' on page 19!

Xerox Doculmage 620S advanced scanner settings

After you have selected your options for the settings in the Scanner Settings dialog box, you can
click the More... button to view or modify additional, advanced scanner setting options in the
Image Quality dialog box. The following are all of the possible advanced scanner setting options
that are provided for the Xerox Doculmage 620S scanner. Only the options that are associated
with the Mode and Dither options that you selected in the Scanner Settings dialog box will be
displayed and available for modification in the Image Quality dialog box at any given time.

e Output Resolution - use this to specify the resolution of the printer where you will output the
document that you are presently scanning.

e Darkness - use this to control the amount of black that is present in an image. A higher
setting results in a darker image overall, while a lower setting results in a lighter image.

e Contrast - use this to control the difference between the light areas and the dark areas of an
image, to increase or decrease the level of the difference among the highlights, midtones,
and shadows in a photograph or fine halftone image. When you increase the contrast, the
light dots in the image become lighter and the dark dots become darker.

e Sharpness - use this to control the degree to which an image appears crisp or contains well-
defined edges. A lower level of sharpness will soften or blur the lines of an image. A higher
level of sharpness will clarify or increase the lines of an image.

- 0 L3
Darkness: D ;I _R% _rl
- 0 L3
Contrast: | E N
- 0 L3
Sharpness: EI ;l _| _;l
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Highlights - highlights are the white and very light gray areas in an image. Use the slide bar
to increase or decrease the whitest or lightest areas of the image.

Midtones - midtones are the light and medium grays in an image. Use the slide bar to
increase or decrease the appearance of the image midtones.

Shadows - shadows are the darkest or blackest areas of an image. Use the slide bar to
increase or decrease the appearance of image shadows.

Highlights: ;ﬁl D_I _'5|

Midtones: jl u_t\lg _:jl

Shadows: [0 ] ;5| _u| _»5|
™ User Defined Gamma

Descreen - use this control to specify the frequency at which the original halftone screen is
removed. When you select this value, choose the highest number that matches the Ipi of the
hardcopy original image, and does not result in a moiré pattern. If the output image contains
a moiré pattern, select a lower frequency. Use Descreen in conjunction with the Halftone
control.

Halftone - use this control to specify the value of the screen you want apply to a Fine
Halftone image that has been descreened. (If you selected Photograph as the document
type, a halftone screen is applied to the photograph without descreening first.)

User Defined Halftone - check this box to use a halftone screen that is not listed in the drop-
down box, then click the Halftone... button to specify the file that contains the screen.

Descreen: | 106 j| Ipi

Halftone: | 42 Ipi

[~ User Defined Halftone
|

User Defined Gamma - check this box to use an alternate curve to determine how the
scanner interprets grayscale data, then click the Gamma... button to specify the file that
contains the curve.

[ Invent Image I_D;User Defined Gamma: | |
i

Reduce Moire - check this box to lessen the appearance of moiré patterns.
5

Reduce Moire: il _% _,I

Reduce Background - check this box to remove or lighten an overall background shade or
color. The scanner will distinguish the difference between the image and the color of the
paper on which it is printed. If the document contains text and/or art that is printed on a dark-
colored paper, the scanned image may be so dark that it is difficult to distinguish the text and
art from the background when you view or print the scanned image. When you use this
option, the background is lightened so the image becomes clearer.

Reduce Pasteup Lines - check this box to remove imperfections from areas in an image
where manual pasting was done on the hardcopy original and has left lines around the added
image area.
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o Light Text - check this box to reproduce light images more clearly. This control will
compensate for text or other marks (such as lines or words written in pencil) that appear
faded when viewed in the scanned image.

* Invert Image - check this box to reverse an entire image, or specified (zoned) area of an
image, so that all blacks are white and all whites are black.

¥ Reduce Background:
#%educe Pasteup Lines
[¥ Light Text

™ Invert Image:

¢ Enhance - use when you select Auto Segmentation for the Dither option in the Scanner
Settings dialog box. Choose one of the following, based on the composition of your hardcopy
original:
— Color Halftones
— Pictures (photos)
— Text and Halftones

Enhance:

Text and Halftones j
Color Halftones

Text and Halftones

Fill options

The following options are available in the Image Quality dialog box only when you select Fill for
the Dither option in the Scanner Settings dialog box:

Xerox Image Quality Fill Pattern E
Fill Pattern:

[omzoniine.—

[~ User Defined Fill Pattern

5

-5 0
Shade: B ] Al _Rls |
Fill Pattern__. |
Cancel | Default |

powt_|

o Fill Pattern (drop-down box) - use this to select which one of the following patterns you want
to fill the entire image or a zoned area of an image:
—  White
— Black
— 45 Degree Diagonal Line
— 135 Degree Diagonal Line
— Horizontal Line
— Vertical Line
— Spiral 106 LPI
— Spiral 85 LPI
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e Shade - use this to increase or decrease the amount of shading you want applied to the
selected pattern. Move the slide bar to the right to darken the pattern, and to the left to lighten
the pattern.

e Fill Pattern... (button) - use this to select a file that contains a fill pattern that is not listed
above.

Example settings for scanning halftones

As stated earlier, there are no certain scanner settings that will guarantee that you will get the
best quality output from your scanned originals. The only way to truly determine what settings you
should use for any given job is to evaluate the input, try various scanner settings, and reevaluate
the output until you find the best combination of settings. Admittedly, this can be a time-
consuming process, particularly when you are scanning fine halftone originals, which are more
complex to work with than straight text or black and white line art. The most serious scan program
users will collect samples of various types of hardcopy original documents (those with light
images, dark images, and with combinations of text, line art, and images, such as faces and
landscapes, that contain varying degrees of darks, lights, and shadows), and use a process of
trial and error to see what combinations of settings produce the best results.

We've provided the following settings for the Xerox Doculmage 620S scanner to help get you
started. Settings are listed for scanning hardcopy, fine halftone images that appear overall to be
light, dark, or somewhere in-between. These may not be just right for each job that you scan and
print, but you may find these to be a good place to begin. It's likely that you will have to make
some modifications on a job-by-job basis.

Based on our example, here's how you would specify the Brightness and Contrast settings for a
hardcopy original Fine Halftone image that is neither very dark nor very light:

Scanner Settings E
Mode: — Brightness | oK I
| Black and White j| & Manual ¢ Automatic
Dither: [N o *[s& Default |
| Fine Halftone j| : Cancel |
Dotz per inch: Darken I Horm | Lighten |
oo =]

Page Size: ~ Contrast More.._ % |
|Leltel -85x11in j| ¥ Manual ¢ Automatic
PE<DFLT ¥ersion 51.202 | 1 ™R :
DOCUG20S Version 1.63 Hilters. |
Region Selection Additional Regions:
Region: Both Main Scans j| Front: EI Back: EI
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Click the More... button to specify the advanced settings for Contrast, Sharpness, Highlights,
Midtones, and Shadows for the same medium original Fine Halftone image:

Xerox Image Quality Fine Halftone E3

Output Resolution:

| 600 DocuTech.DocuPrint j|
—Basic Settings

-5 0 5

Darkness: EI ;l _| _>|
-5 0 L]

Contrast: El K 3|
-5 0 L]

Sharpness: El ;l _| _>|
Descreen: | 106 j| Ipi
Halftone: | a5 j| Ipi
[™ User Defined Halftone

|
—Advanced 5ettings 5 0 5
Highlights: A [
-h 0 Li]

Midtones: El ;I _I_I’
-5 0 5

Shadows: i o

[ Invert Image

[™ User Defined Gamma

Halftone__.

Cancel |

Gamma._.

Default |

L Ok | "

Information about how to access the Scanner Settings dialog box is described in "Viewing and
modifying scanner settings!' on page 14,

The options you can set in the Scanner Settings and Image Quality dialog boxes are described in:
e "Xerox Doculmage 620S scanner settings" on page 16
e "Xerox Doculmage 620S advanced scanner settings" on page 19
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Enhancing images in an Infoprint Scan document

You can improve the appearance of a scanned document using Infoprint Scan's image
enhancement functions. Infoprint Scan provides a number of options that you can set for image
enhancement. There are no particular settings for these options that will guarantee the best
quality output. You determine the settings you need for the best quality output on a job-by-job
basis by estimating the quality of your input, and by how the output appears on observation.

You can specify the settings and have Infoprint Scan enhance images:

¢ Immediately after the document is initially scanned.
¢ On adocument or specified pages of a document that has already been scanned.
e When you add or replace pages in, or append pages to a scanned document.

The information in this section will explain your options to help you determine what enhancement
settings you should use. Information is provided in the following topics:

¢ "Enhancing images in an Infoprint Scan document” on page 25
e "Enhance images in a previously scanned document" on page |29
e "Selecting enhancement options" on page 31
e "Enhancement options and settings" on page 34
Remember!

Image enhancement permanently changes the images. After enhancing, you cannot return
the document to its original scanned condition.

The following procedures are applicable only when you are using the Infoprint Scan standard
interface. If it is available with your version of Infoprint Scan and you want to use the alternate
copier interface, refer to "Using the Infoprint Scan Copier interface! on page 119|for information.

Enhance images when scanning a new document

Important!

e If you have invoked Infoprint Scan from within the Infoprint Submit program, place your
original hardcopy document in the scanner, skip steps|1|through 4, and begin with step 5.

o If you are using Infoprint Scan as a stand-alone application, begin with step 1.

To scan and create a new document:

1. Open Infoprint Scan and place your original hardcopy document in the scanner's document
feeder. For the Xerox Doculmage 620S scanner, position the pages face up, inserting the
sheets with the short edges leading. For other scanners, refer to the manufacturer's
instructions.

2. Click File in the menu bar and then click New Document....

Optionz  Help

MNew Document. . kI:Zt i+t I
Opeh...

Exit
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3. Inthe Create New dialog box:
a. Select the directory into which you want to save the scanned document.
b. Type a name for the Infoprint Scan document in the File name field. This name will also
be used for the name of the job ticket when you submit the document for printing.
c. Inthe Save as type field, be sure Job Ticket Files (*.jtk) is selected.

Create Hew E |

Save i I £ Scan Jobs

m Examplel . jtk

File name: IScanDDc.itk
Save a5 lype: |Job Ticket Files [*tk) =] Cancel |

4. Click the Save button.
5. Click File in the menu bar and then click Scan....
XN Edit Page “iew T

HEW. {5t i
EE.. {5 il
Cloze

NS
Bemaove...
Export...
Submit Job... Chrl+d
Frirt... Chrl+F
E xit
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6. Inthe Original area of the Scan Document dialog box, select:
e One-sided if the original hardcopy document is printed on just the front side of the paper.
e Two-sided if the original hardcopy document is printed on both the front and back sides
of the paper. See "Scanning Two-Sided Originals' on page [113/for additional information
about scanning two-sided originals.

Scan Document |

= TwoSided  Change Settings |

— Oniginal

[ Landscape

fode; Black and“white
Reszalution :  B00 dpi
Original Size : | etter - 8.5 % 11 in

[T Custom Page size I " I inches

— Location

% append to end of curent docurment

Scan Cloze Help
N | e |

7. Check the Landscape check box only if you want to rotate the output image 90 degrees
clockwise.

8. Click the Change Settings button to view or change the scanner settings.
(Refer to "Setting up the scanner’" on page 13 for detailed information about scanner
settings.)

9. If your original hardcopy document has a page size that is not listed among the scanner
settings options, check the Custom Page size check box and enter the dimensions in the
fields provided.

10. Click the Scan button.
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11. When scanning has completed, the Append Scan Document dialog box will open. If you want
to scan more pages to add to specified locations in the new document, place your hardcopy
originals on the scanner, and repeat these instructions, beginning with step 5.

Append S5can Document |

= TwoSided  Change Settings |

— Original

[T Landscape

b ode; Black and“white
Resalition ;600 dpi
Original Size : Letter - 8.5 % 11 in

[T Custom Page size I " I inches

— Location

& Append to end of curent document
i~ Ingert befare cument page
™ Inzert after current page

" Feplace curent page

Scan I Cloze kJ

12. Click the Close button in the Append Scan Document dialog box to return to the new, open

document.

13. If you will be enhancing the image on just one page, make that page current by using the
buttons on the tool bar or the available options in the View menu. (See "Navigating through

an Infoprint Scan document” on page 115|for information.)

14. Click Tools in the menu bar and then click Enhance....

28

I|:||:||:5: thicuns ﬂEll:'

Benumber Pa!g

Eraze Fegion
[ada Eraze
Add Text..
[Hrdo Tiext

EopuChanges
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15. See "Selecting enhancement options” on page 31|for information about the options in the

Enhance Image dialog box.

Enhance Image

................................

" Document

" Pages I

% &l pages
) Dddlpages

) Evenpages

— Enhance Options

W Deskew = 1
Change Settings
[T Despeckle _i_ -4 i
V¥ Auto-Crop il = l
[ autoFotate Portrait 1| = =5
[T Fegistration Yertical = on
-
[ Reqistration Horizontal l l
[T Sand and Fill [ lInvert Image
Fotate: INnne j
| Enhance [:I Cancel | Help

=

16. After the image enhancement has completed, click File in the menu bar and then click Close

to close and save the document, or Exit to close and save the document and exit the

Infoprint Scan application.

Enhance images in a previously scanned document

To enhance the images in a document that has been previously scanned:

1. Invoke Infoprint Scan and click File in the menu bar and then click Open... to open the

Infoprint Scan document that you want to enhance.

Options  Help
MNew Docurnent... Cril+M

hh)
E xit
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If you will be enhancing the image on just one page, make that page current by using the
buttons on the tool bar or the available options in the View menu. (See "Navigating through
an Infoprint Scan document” on page 115|for information.)

Click Tools in the menu bar and then click Enhance....

I EE Option:  Help

Benurmber F"a!g

Eraze Region
[ade Erase
Add Test...
e et

[Eapy Ehanges

See "Selecting enhancement options” on page 31 for information about the options in the
Enhance Image dialog box.

Enhance Image =] |
—Apply To
& Lunent page | | Al pages
' Docurneit ) Ddd\pages
*" Pages I 0] Evern pages

— Enhance Options
¥ Deskew - i
Change Settingz

[T Despeckle _i_ - i

¥ Auta-Crop L= |1

[T AutoRotate Portrait 71 = f_

[ Fegistation Yertical g e

-+

[~ Fegistration Haorizontal l l

[T Sand and Fill [ Inwert Image
Ratate: MHaone j

| Enhance EI Cancel | Help
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5. After the image enhancement has completed, click File in the menu bar and then click Close
to close and save the document, or Exit to close and save the document and exit the
Infoprint Scan application.

Selecting enhancement options

You can select the enhancement options that you want Scan to perform when a new or
previously created Infoprint Scan document is open, as described in:

"Enhance images when scanning a new document" on page 25
"Enhance images in a previously scanned documeni" on page 29

With an Infoprint Scan document open, do the following:

1. Click Tools in the menu bar and then click Enhance....

Il:ll:ll:E: thil:nr'm HE'F‘

Benurmber F"a!g

Eraze Region
[ade Erase
Add Test...
e et

[Eapy Ehanges

2. Select one of the following in the Apply to area of the Enhance Image dialog box:

Current page - to apply the enhancements only to the page that is currently displayed.

Document - to apply the enhancements to the document as specified with:

— All Pages - to apply the enhancements to all pages in the document.

— Even Pages - to apply the enhancements to all even-numbered pages.

— 0dd Pages - to apply the enhancements to all odd-numbered pages.

Pages - to apply the enhancements to a specific page or pages, orto a

range of pages.

— For an individual page, type the page number of the page you want to print in the
field provided.

— For specific pages, type the numbers of all of the pages you want to print, each
separated by a comma (such as, 3,9,11,24).

— For arange of pages, type the number of the first and last pages you want included,
separated by a dash (such as, 15-20).

— You can also specify individual pages along with a range of pages (such as,
3,9,11,24,15-20).

— Do notinclude spaces after the commas.
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Enhance Image x|

—apply To
© i )il
" Document ) Iddlpages
" Pages I {*) Ever pages

— Enhance Options
¥ Deskew g L
Change Settings

[T Despeckle i_ -, _i_

W Auto-Crop L= i

[T &utoRotate Portrait _'1 -y '\f

™ Registration Yertical o e

-

™ Registration Horizontal i l ‘

™ Sand and Fil ™ Inwert Image
Rotate: Mone j

Enhance |~_\ I Cancel | Help

In the Enhance Options area, you can select the following options:

Note: Any or all of the enhancement options can be selected at one time.
(See "Enhancement options and settings|' on page [34 for additional information about
each of the options.)

o Deskew - adjusts and corrects the angle at which a document is skewed, so the page
and lines are aligned properly.
(See "Fixed Image Size!' on page 38|for important information related to using Deskew.)

e Despeckle - removes isolated, unwanted specks that may occur during scanning.

e Auto-Crop - eliminates an edge or border around a page that does not match the rest of
the page.

o AutoRotate Portrait - when this is selected, if Scan finds a page of text that is upside
down, it will automatically rotate the page, so that the text is right side up.

¢ Registration Vertical - positions text and data vertically on the page to provide
consistent side margins.

o Registration Horizontal - positions text and data horizontally on the page to provide
consistent top margins.

See "Registration tips'' on page 37 for additional information about using the Registration
options.
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e Sand and Fill - smoothes the edges of characters by filling in small pits and removing
small bumps. Applying this option will improve the appearance of characters and reduce
the compressed image file size.

¢ Invert Image - reverses the image so that all blacks are white and all whites are black.

On a "positive" image, the effect is similar to that of a photographic negative, shown in
Figure 1. (Conversely, a negative image is made positive.)

Printing

Figure 1. The entire page image is inverted.

Note: This function works only on the image of the entire page - if you want to reverse
the image in just a specified area of the page, use the Invert Layer option in the
Edit menu. For additional information, refer to page 97|of the "Modifying layers
with Infoprint Scan! topic.

¢ Rotate - rotates pages by a specified number of degrees from their current orientation.
Options include:

MHone

R aotate:

90 deqrees clockwize
180 degrees clockwize
270 degrees clockwize

— None - do not rotate the page

— 90 Degrees Clockwise -rotate the page 90 degrees clockwise (1/4 turn) from the
current orientation. For example, this would cause a portrait (vertical) page to display
or print in a landscape (horizontal) format.

— 180 Degrees Clockwise - rotate the page 180 degrees clockwise (1/2 turn) from the
current orientation. For example, a portrait (vertical) page would display or print with
the head and foot areas of the page in reversed positions.

— 270 Degrees Clockwise - rotate the page 270 degrees clockwise (3/4 turn) from the
current orientation. For example, a landscape (horizontal) page would display or print
with the head and foot areas of the page in reversed positions.

(See "Fixed Image Size'" on page 38|for important information related to using Rotate.)

4. Click the Change Settings button to modify the enhancement settings. See "Enhancement
options and settings" on page 34| for information.
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5. Click the Enhance button to enhance the image(s) based on the default or your modified
settings.

6. Click the OK button in the message window when the image enhancement is completed.

InfoPrint Scan |

& Image Enhance Successful

Enhancement options and settings

The following information is provided to describe the image enhancement options and to help you
determine what values to set for these options.

FYI: In case you're not familiar with the term, a pixel is another word for pel, or picture element.
This is defined as the smallest scanable, printable, or displayable unit on a physical medium
or display surface. The pixel, or pels per inch (ppi), is often used as a measurement of
presentation granularity.

Deskew ® I

Deskew adjusts and corrects the angle at which a document is skewed, so the page and lines will
be aligned properly. Skew is the position of paper going through the scanner's paper path at a
slight angle, causing the scanned lines to not be aligned properly.

iy

Deskew settings

In the Enhance Settings dialog box, move the slide bars in the Deskew Sensitivity area left to
increase the values or right to decrease the values.

Enhance Settings |

— Dezkew Sensitivity

Acceptable Skew ID_Eﬁ 4 200 — | 01
Detection Length  [300 || pixels 0 _I\ 1900

e Acceptable Skew - sets the maximum amount of skew that is accepted. Any image with less
skew than the set value will not be corrected. Lowering the value will cause more images to
be corrected, and raising the value will cause fewer images to be corrected. Setting to a
lower value will result in higher scanning speed, since more images are left as is. For
example, the original default setting is 0.671%. This results in an image with no more than
150 horizontal pixels for each vertical pixel of skew. A lower setting of 0.5% results in an
image with no more than 200 horizontal pixels for each vertical pixel of skew, and a higher
setting of 1% results in an image with no more than 100 horizontal pixels for each vertical
pixel of skew.
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o Detection length - indicates the shortest line, in pixels, to be used to detect skew. This value
should be at least 25% larger than Acceptable Skew. The original default is 300 (1 inch at
300 dpi).

See "Fixed Image Size" on page 38/for important information related to using Deskew.

i
)
1
T

o

L -
Despeckle ==
Despeckle removes isolated, unwanted specks that may occur during scanning.

ol

Despeckle settings

In the Enhance Settings dialog box, move the slide bars in the Despeck Sensitivity area right to
increase the values or left to decrease the values.

— Despeck Senzitivity

. I:I 1 1 1 k. 1 1 1 1 1 1 1 I:l

|zolated zize 4 . 3 {

I I : 4 :

pirelz L
I:I L‘. 1 1 1 1 1 1 1 1 1 1 I:I
Wertical size I':' pixelz ]

Harizontal size II:I pirelz 0 j 10

e Isolated size - determines the size of isolated specks that are removed. Larger values can
cause periods and the dots on letters such as j to be removed. The original default is 4.

e Vertical size - examines each vertical line 1 pixel wide and deletes all groups of pixels with a
length less than the value specified. Larger values will remove larger specks. If the value is
too high small segments of characters will be removed. The original default is 0.

o Horizontal size - examines each horizontal line 1 pixel wide and deletes all pixels with a
length less than the value specified. Larger values will remove larger specks. If the value is
too high small segments of characters will be removed. The original default is 0.

|

-
|

-

-,

L]
L]

Cropping
Cropping eliminates an edge or border around a page that does not match the rest of the page.
For example, if you have specified that your Infoprint Scan document will print on an 8.5 inch x 11
inch page, but the original hardcopy document is smaller than 8.5 x 11 inches, without cropping,
you would get black borders on the scanned pages, the width of the difference in size between
the original pages and the scanned pages. With Auto-Crop turned on (selected) Scan will
automatically eliminate the unwanted borders.
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Auto-Crop settings

In the Enhance Settings dialog box, click the arrow in the Cropping area and highlight an Auto-
Crop option.

Cropping

Auto-Crop Crop Black

o

Crop "White e

e Auto-Crop - specifies the color of unwanted borders or edges that are to be eliminated from
pages. Choices are:
— Crop Black - Scan will eliminate black borders or edges from around pages. This is the
original default.
— Crop White - Scan will eliminate white borders or edges from around pages.

1
L]

1| =1

.
&Y

I
s

Registration

Registration is used for page alignment. With this tool, you can position text horizontally and
vertically on the page to provide consistent side and top margins.

Registration settings

In the Enhance Settings dialog box, in the Registration area, type the values you want for the left
and top margins, and select or deselect the Central Focus and Add Only check boxes.

— Reqiztration

Resultant Bind kargin II:I piselz [~ CentralFocus [~ Add Only
Resultant Duter kargin ID pirels [~ CentralFocus [ AddOnly
Fesultant Top Margin ||:| pizel: [~ Central Focus [ &dd Only

e Resultant Bind Margin - determines how many pixels will remain as the bind margin (for a
two-page spread - or facing pages - the left margin on an odd-numbered page, or the right
margin on an even-numbered page) after processing. Scan locates the bind edge of the text
or data and positions the bind edge of the image the specified number of pixels from the bind
edge of the text or data. Setting this value to 0 places the text or data flush with the bind edge
of the image. A negative value crops the specified number of pixels from the bind edge of the
text or data.

¢ Resultant Outer Margin - determines how many pixels will remain as the outer margin (for a
two-page spread - or facing pages - the right margin on an odd-numbered page, or the left
margin on an even-numbered page) after processing. Scan locates the outer edge of the text
or data and positions the outer edge of the image the specified number of pixels from the
outer edge of the text or data. Setting this value to 0 places the text or data flush with the
outer edge of the image. A negative value crops the specified number of pixels from the outer
edge of the text or data.

¢ Resultant Top Margin - determines how many pixels will remain as a top margin after
processing. Scan locates the topmost edge of the text or data and positions it a fixed distance
from the top edge of the image. Setting this value to 0 places the text or data flush with the
top edge of the image. A negative value crops the specified number of pixels from the top
edge of the text or data.
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Central Focus - causes Scan to register using only the middle portion of the image border.
This is useful for ignoring edge noise, letterheads, and logos. You can activate this for the
resultant bind margin, the resultant outer margin, the resultant top margin, any or all of these
margins at one time, or none of the margins.

Add Only - causes Scan to expand the current margin (if it is smaller than the specified
value) to the size specified for the Resultant Bind, Outer, or Top Margin. You can activate this
for the resultant bind margin, the resultant outer margin, the resultant top margin, any or all of
these margins at one time, or none of the margins.

Determining pixel values
To determine the value in pixels to enter for the resultant bind, outer, and top margins, multiply
the dimension you want for the margin by the scanned resolution of the image.

Example:

As an example, let's say you want to center the body of text on a 6-inch wide x 9-inch long page,
so that both the bind and the outer margins are the same. Assume that you have scanned the
image at 600 dpi.

1.

2.

Measure the line length of the text, using the longest line on the page. For this example,
assume that the line length is 4.5 inches.

Subtract the line length from the width of the page.
6.0 inches — 4.5 inches = 1.5 inches
This leaves a total of 1.5 inches for the margins.
Since there are two margins, divide the remainder by 2.
1.5inches +2 = .75 inch
For this example, the resultant margins are each .75 inch.
To convert this to pixels, multiply the width of each margin by the scanned resolution (600 dpi
for this example).
.75 inch x 600 dpi = 450 pixels
For this example, you would enter 450 for the value in both the Resultant Bind Margin and
Resultant Outer Margin fields.

Note: Remember to adjust the values if you want a wider bind margin than outer margin, to allow

additional room for 3-hole punching, saddle stitching, or other types of binding. For
example, if you want the bind margin to be 1 inch, and the outer margin to be .5 inch, for
an image scanned at 600 dpi the resultant bind margin will be 600 pixels (1 inch x 600
dpi), and the resultant outer margin will be 300 pixels (.5 inch x 600 dpi).

Registration tips

When you use Registration, you should also activate Deskew unless you know that the
original is perfectly straight.

You can activate and set the parameters for horizontal (bind and outer edges of an image)
and vertical (top edge) registration separately.

For most operations where you require consistent bind and outer margins, you should
activate horizontal registration. In many cases, you can leave vertical registration deactivated.
For applications where precise text location is important, you should activate both horizontal
and vertical registration.

When you have finished specifying all of the settings, click the Save button in the Enhance
Settings dialog box.

To return all of the settings to their original defaults, click the Default button in the Enhance
Settings dialog box.
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Fixed Image Size

If the Do not allow Enhance to modify image size check box is not selected, Enhance will
proportionally resize the image, when necessary, to fit on the page. When the box is selected
(checked), Enhance will not resize the image.

[+ Do nat allow Enhance to modify Image Size!

"Fi:-:ed Image Size

Cancel Defaultz Help

e Be sure to check this box when Deskew is selected.

e Be sure that this box is not checked when you have selected to Rotate the image and want
the entire image to fit on the rotated page (such as when an image with a portrait, or vertical
orientation is rotated 90 or 270 degrees to a landscape, or horizontal orientation).
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Printing Infoprint Scan documents

Notes:

e Printing options are not available when Infoprint Scan is invoked from within the Infoprint
Submit program. For information about submitting print jobs from within the Infoprint Submit
program, refer to the online help that is provided with that program. The following
information is applicable only when you use Infoprint Scan as a stand-alone application, or
when you use Infoprint Scan 2000.

e The following procedures are applicable only when you are using the Infoprint Scan
standard interface. If it is available with your version of Infoprint Scan and you want to use
the alternate copier interface, refer to "Using the Infoprint Scan Copier interface/' on page
119 for information.

You have some options for how to print scanned documents from Infoprint Scan. Depending on
how your system is set up, you can:

¢ Print Infoprint Scan documents on a locally attached printer
Information begins on page [39.

Or, when Infoprint Manager is installed, you can:

e Submit a print job to the Infoprint server for printing.
Go to page 40 for information.

Alternately, you can:

e Export an Infoprint Scan document as a PDF file/that can be viewed online or printed.
Go to page 52 for information.

Note: The Export function is always available when there is an open document in Infoprint
Scan, including when Scan is invoked from within the Infoprint Submit program.

Go "PDF files' on page 54 for some information about PDF files and PCL drivers that can help
you decide when to use local printing, and when to use the Export function.

Print Infoprint Scan documents on a locally attached printer

You can use your Windows printer drivers to select the Infoprint 2000, or, if applicable, another
printer that is attached directly to your workstation or to a LAN.

To print on a locally attached printer:

1. With a scanned document open and displayed in the Infoprint Scan main window, click File in
the menu bar, and then click Print....
H=W Edit Page “ew T
[Hew .. (7l

Een.. [+
Cloze

Scan...

Bemowve...
Export...

Submit Job... Chl+d

bt
E xit
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2. Inthe Windows Print dialog box, select the printer in the Name field, and set other options
and properties, as applicable.

N T

— Printer

Mame: Infoprint 2000 [PCL) j FProperties |

: : &crobat PDFPwriker

balus | A nple Laserwhiter 1| NT
Type: Colorde: 004 DF-3

~ |Default PostScript Printer
Whers: | InfoPrint G

Comment:  dldis Ty e | [ Print o file
PR24 004 D79
— Print range — Copies
% 4l & pages Murnber of copies: 1 -

" Pages [rl:-m:l'l la: |6
7] Selection Ijl ™ Callate
ITI Cancel

3. Click OK to print the scanned document.

Submit a print job to the Infoprint server

You can submit a print job to the Infoprint server, where it will be scheduled for printing. This also
allows you to define and modify print and RIP options and to check print status.

Note: To submit a print job to the Infoprint server, you must have Infoprint Manager installed. If
you are using Infoprint Scan 2000 without Infoprint Manager, go to "Print Infoprint Scan
documents on a locally attached printer" on page 39 or "Export an Infoprint Scan
document as a PDF file" on page 52 for instructions.

When you submit a job to the Infoprint server for printing, you open the Scan Print dialog box
where you can set print options, RIP options, retention times, and specify how the document
should look when it is printed. Refer to the following topics for information about submitting a
Scan print job:

e "Submitting a job" on page 41

e "Setting options for the Infoprint Scan document print job" on page 42

You can also set your preferences (default values) for printing, page layout, and schedules,
update your printing options, and check on the status of your submitted print jobs. For more
information, refer to:

e "Setting preferences" on page |46

o "Refreshing printing options" on page|50

e "Checking print job status/' on page |50
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Submitting a job

To submit a job to the Infoprint server:

1.  With a scanned document open and displayed in the Infoprint Scan main window, click File in
the menu bar and then click Submit Job....
[X[=W Edit Page “ew T
Hew.. 5t

Een.. Bt =
Cloze

Scan...

Bemove...
Export...

SubritJob... Cti+) |
Frirt... k

E xit

2. Set options for the job in the Scan Print dialog box. This dialog box contains three tabbed
pages where you can set print options, RIP options, retention times, and specify how the
document should look when it is printed.

"Setting options for the Infoprint Scan document print job on page 42 describes the attributes
that can be set for Print, Schedule, and Layout.

3. When you have finished setting the options for Print, Schedule, and Layout, click OK to
submit the document for printing.
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Setting options for the Infoprint Scan document print job

When you submit a job to the Infoprint server for printing, you open the Scan Print dialog box,
which contains three tabbed pages:

e From the Print page, you can change and select print options.
e From the Schedule page, you can specify RIP options, retention times, and print priority.
e From the Layout page, you can specify how the document should look when it is printed.

The available options will change, depending upon which tab is selected.

Setting Print options

Click the Print tab in the Scan Print dialog box to set these options:

Scan Print - testit_jtk | X|
Print |Schedule| Layoutl
Description IThis iz a test joH] Frint Jab 1D IScan.DEﬁ
Prirter Type ||nfDP[int4|:||:||:| j Eaper IUse server default j
Printer Idemn4DDD-iris j Stacker IUse zerver default j
Lopies ta print I1 j [ Proof. do not optimize for multiple copies
Pages to print
Lo 1o 4
" Pages
for example 1.4,7-11
QK I Cancel | Help |

o Description - Type a description for the job ticket. The text can consist of of alphabetic or
numeric characters. This field is optional.

e Printer type - Select the type of printer you want to use for printing the Infoprint Scan
document.
(Use Preferences from the Options menu to set the default value for this option.)

e Printer - Select the name of the printer you want to use for printing. The printer names listed
are logical printers as defined to the server. The printers listed are all of the types specified
for Printer type.

e Copies to Print - Specify the number of copies to print. Type a number or click the up and
down arrows to specify the number you want.

e Proof, do not optimize for multiple copies - use this to save time when printing multiple
proof copies on the Infoprint 4000. When checked, optimizes for a single copy on the Infoprint
4000; the pages are not saved at the printer and will be loaded for each copy printed. When
not checked, the pages are saved at the printer and are not loaded for each copy printed.
Available only when the Infoprint 4000 is specified as the Printer Type.
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e Pages to Print - Specify which pages in the document you want to print. Select from the
following:

— All - Prints all of the pages in the document.

— Pages - You can specify a page, specific pages, or range of pages to print. Type the
page(s) and/or page range in the field provided.

e Print Job ID - Specifies the job ID of the print job. The Job ID is composed of the string
Scan, followed by a suffix that indicates the number of times the job was submitted. The
suffix is incremented by one each time you submit a job with this job ID. This is a read-only
field.

e Paper - Select the paper to use when printing the document. The list of available paper types
is based on the printer you selected in the Printer type field.

e Stacker - Select the output stacker for printed output on your Infoprint 60.
(Use Preferences from the Options menu to set the default value for this option.)
Available only when the Infoprint 60 is specified as the Printer Type.

Setting Schedule options

Click the Schedule tab in the Scan Print dialog box to set these options:

Scan Print - testit_jtk E3

Frint  Schedule | Layout I

— RIP Opti _
[P Retain job at zerver

f* [io nat retain at server

 FIF anly " Retain for IEI IHnurs vl
" RBIP then hald
" Print

Pricrity |5 _|::'

™ | Bimwithaut waiting

Dutput sppearance IUse server default |

Scresn frequency IUse server default j

0k I Cancel | Help |

¢ RIP Options - Specifies processing instructions to the server before printing. Select from the
following:

— Use server default - uses the Infoprint server's default setting.
— Hold - holds the job at the server until you release it for printing.

— Rip Only - RIPs the data without printing or holding the job. Error messages are sent
from the server to the Message window only if you specify a Retain value; otherwise, no
messages are returned from the server.

— Rip then hold - RIPs the data and holds the job at the server until you release it for
printing.

— Print -RIPs the data (if needed) and prints the job. (Use Preferences from the Options
menu to set the default value for this option.)
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* Retain job at server - Specifies whether to retain the document on the server after printing.

Select from the following:

— Do not retain at server - specifies that the print job not be retained at the server. Job
status messages are not returned to the Job Message window when you select this
option. Click another option to deselect this option.

— Retain for __ Hours or Days - when you select the Retain for option, the time and units
fields are made available. Use the time and units fields to set the retention period for the
job at the server. Type a number in the field provided and select Hours or Days. The
default value is 1 day. Click another option to deselect this option.

(Use Preferences from the Options menu to set the default value for this option.)

Note: Storing documents on the server takes up space on the hard drive and should be
done conservatively and only temporarily.

e Priority - Determines the order of importance for printing the document. Type or select a
number to specify the priority of the job. Valid values are numbers from 1 to 10 (10 is the
highest priority).

(Use Preferences from the Options menu to set the default value for this option.)

Note: Documents having the same priority will print on a first come, first served basis.

e Output appearance - Specifies the output appearance (or style) for the document, and is
used to determine the dark and light levels when halftoning TIFF grayscale data. Select from
the following:

— Use server default - uses the Infoprint server's default setting.

— Standard

— Highlight midtones - shows more levels of gray (more contrast in the middle tones, less
for the most dark and most light).

— Dark - makes halftones print darker overall.

(Use Preferences from the Options menu to set the default value for this option.)
e Screen frequency - Specifies the screen frequency value, or resolution of the halftone
screen that is used for halftoning TIFF grayscale data. Select from the following:

— Use server default - uses the Infoprint server's default setting
- 7

- 85

- 106

- 14

(Use Preferences from the Options menu to set the default value for this option.)

Setting Layout options

Click the Layout tab in the Scan Print dialog box to set these options:
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Scan Print - testit_jtk E3

Print IScheduIe La.'HUUtl

Lapout ISimpIe 2-up j

1.2

Sides IDupIer: j

Image fit

" Scale to page Show Back

(]9 I Cancel | Help |

Layout - Specifies the output format (or page layout) you want to use for printing the
document.
(Use Preferences from the Options menu to set the default value for this option.)

Sides - Specifies the sides of the paper on which a document is to be printed. This field is not
available when booklet 2-up is selected for Layout and when a form definition is used. Select
from the following:

— Use server default - uses the Infoprint server's default setting.
— Simplex - prints on one side of the paper.
— Duplex - prints on both sides of the paper.

— Tumble - prints on both sides of the paper so that the top of one side of the sheet is at
the same end as the bottom of the other side. Sometimes referred to as "head-to-foot"
printing.

Tip: Keep in mind that if the hardcopy document was originally printed and also scanned
with a tumbled arrangement of pages, and you want to keep the tumbled arrangement for
printing now, you should not specify Tumble for the Sides value. Tumble causes every
other page of the document to be rotated 180 degrees. If the document is already
tumbled, the Tumble option will "untumble” it when it is printed. Verify the sides
arrangement of your document by scrolling through the pages in the display area of the
main Infoprint Scan window.

° If every other page is rotated 180 degrees, and you want this document to be
printed head-to-foot, do not specify Tumble - instead, specify Duplex to print the
scanned document exactly as it is displayed.

°  Conversely, if every other page is already rotated 180 degrees, and you want to
"untumble” the document so that it now prints with a head-to-head arrangement,
specify Tumble for the Sides value.

(Use Preferences from the Options menu to set the default value for this option.)

Image fit - Specifies whether to scale the image or trim the image to fit the image to the
finished page size. Select from the following: Scale to page Proportionally resizes the image
to fit on the finished page. Trim to page Trims, or crops the outside edges of the image to fit
on the finished page. (Use Preferences from the Options menu to set the default value for
this option.)
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A graphic representation of the printed page layout is displayed on the right side of the
Layout page using the selected layout and sides values. Click Show back to display the back
side of the paper. This button is active when duplex or tumble is selected for the Sides value.

Setting preferences

You can specify your preferences for what will be used as the default values for the Printing,
Layout, and Schedule options that are available the Scan Print dialog box.

Notes:

Changing your preferences in Infoprint Scan will also change the preferences in Infoprint
Submit running on the same workstation. Conversely, if preferences are changed in Infoprint
Submit, the preferences will also be changed in Infoprint Scan.

Keep in mind that when you create a print job for an Infoprint Scan document, certain print
option values, based on preferences as they are set at the time the job is created, are saved
in the job ticket. If you resubmit the job at a later time, and preferences have since been
changed, the job will ignore the new preferences and use the values that are saved in the job
ticket. The values for the following options are saved in the job ticket: Printer Type, Output
appearance, Screen frequency, Layout, Sides, and Page Content. The RIP Options, and
values for Stacker, Priority, and Complexity are saved for the printer that is specified in
Printer Type.

To set your preferences (default values) for printing, page layout, and schedules:

1.

3.

With a scanned document open and displayed in the Infoprint Scan main window, click
Options in the menu bar, and then click Preferences....

Option: WalE

Enhance Settings ...
Scanner Settings. ..
Server Settings...
Erint Job Status

EEEEECN
Refrezh

Background Colar. .
Select Scanrer...

Set your preferences for default values in the Preferences dialog box. This dialog box
contains three tabbed pages. Go to each of the following for an explanation of the attributes
that can be set for:

e From the Print page, you can select the default values for Print options.

e From the Layout page, you can select the default values for Layout options.

¢ From the Schedule page, you can specify the default values for Schedule options.

The available options will change, depending upon which tab is selected.

When you have finished setting your preferences, click the OK button.

Setting Print Preferences

Click the Print tab in the Preferences dialog box to set these defaults:
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Preferences E

Prinit %l Layout I Schedule I

Printer type IInfu:nF'rinl 5] j
Stacker | 5ide [~
Faper |Letter j
Sereen frequency IUse server default j
QOutput appearance IStandald j
Bits per spot |Use server default =l
Quark SetTrap IUse server default ﬂ
Black awerprint IUse zerver default j

] 4 | Cancel |

e Printer type - Select your preference for the type of printer used by default to print your
documents.

e Stacker - Select your preference for which output stacker on the printer is used by default for
printed output.

e Paper - Select your preference for the default for the size of paper to use when printing.

e Screen frequency - Select your preference for the screen frequency used to print your
documents. This specifies the screen name to use for the screen frequency value, or
resolution of the halftone screen that is used for halftoning PostScript or TIFF grayscale data.

e Output appearance - Select your preference for the output appearance (or style) of your
printed documents. This is used to determine the dark and light levels when halftoning
PostScript or TIFF grayscale data. Selecting Highlight midtones results in more contrast in
the middle tones, less for the most dark and most light. Selecting Dark makes halftones print
darker overall.

o Bits per spot - Select your preference for the number of bits used to describe the gray value
for each pixel. A value of 2 allows four levels of gray, from 0 to maximum density; a value of 4
allows sixteen levels.

e Quark SetTrap - Select Yes if you prefer to enable trapping for Quark Xpress jobs or No if
you prefer to disable trapping.

o Black Overprint - Select Yes if you prefer to print black over colors, or No if you prefer to
omit colors from areas where black will be printed.

Setting Layout Preferences

Click the Layout tab in the Preferences dialog box to set these defaults:
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Preferences E

Pritat La}'%‘ | Schedulel

Layout ISimpIe 1-up ﬂ
Sides IDupIeH j
— Image Fit

£+ Trim to finished page size

" Scale tao finished page size

— Unitg—————— Decimal Motation
= Millimeters & Ise . as delimiter
& dnches  Use , as delimiter

0k I Cancel | Help |

Layout - Select your preference for the default output format (or page layout) used to print
your Infoprint Scan documents.

Sides - Select your preference the default for how documents will be printed on the paper:

— Use server default - use the Infoprint server's default setting.

— Simplex - print on one side of the paper.

— Duplex - print on both sides of the paper.

— Tumble - prints on both sides of the paper so that the top of one side of the sheet is at
the same end as the bottom of the other side. Sometimes referred to as "head-to-foot"
printing.

Image Fit group box - Select your preference for whether to trim or to scale the image to fit

the finished page. Select from the following:

— Trim to finished page size - trims, or crops the outside edges of the image to fit on the
finished page.

— Scale to finished page size - proportionally resizes the image to fit on the finished page.

Units - Select your preference between millimeters and inches for the default Units value.

Decimal Notation - Select your preference for the character used as a decimal delimiter.

Setting Schedule Preferences

Click the Schedule tab in the Preferences dialog box to set these defaults:
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Ptk ILayu:uut SChEdel
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" Hold & For IE Im
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0k [:I Cancel | Help |

¢ RIP Options - Select your preference for the default RIP option from the following:

Use server default - uses the Infoprint server's default setting.

Hold - holds the job at the server until you release it for printing.

Rip Only - RIPs the data without printing or holding the job. Error messages are sent
from the server to the Message window only if you specify a Retain value; otherwise, no
messages are returned from the server.

Rip then hold - RIPs the data and holds the job at the server until you release it for
printing.

Print -RIPs the data (if needed) and prints the job.

o RIP without waiting - select (check) this box to RIP the data whether all resources that the
job requires, such as fonts and media, are ready on the printer or not. Deselect this box to
hold the job without RIPping if any required resources are not ready.

+ Retain job at server - select your preference for retention of the job on the server after
printing. Select from the following:

Do not retain - specifies that the print job not be retained at the server. Job status
messages are not returned to the Job Message window when you select this option.
For __ Hours or Days - type a number in this field (when For is selected). This value
combined with the units (select Hours or Days) specifies the amount of time to retain the
job at the server.

Note: Storing documents on the server takes up space on the hard drive and should be
done conservatively and only temporarily.

e General - Select your preferences for default values for the following:

Priority - Determines the order of importance for printing the document. Type or select a
number to specify the priority of the job. Valid values are numbers from 1 to 10 (10 is the
highest priority).

Complexity - Type or select a number to specify the complexity of a job. Valid values are
numbers between 1 and 10 (10 is the most complex).. The makeup of a job determines
its complexity. For example, a large document that contains many halftone images is
more complex than a short, text-only document.

When you have finished setting the default values to be used for Print, Layout, and Schedule,
click the OK button to save your settings.
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Refreshing printing options

Use Refresh to update your options for printing, scheduling, and page layout, to be sure that the
most current settings are used for default values.

To refresh your printing, scheduling, and page layout options:
e Click Options in the menu bar, then click Refresh.

Option: WalE

Enhance Settings ...
Scanner Settings. ..
Server Settings...
Erint Job Status
Preferences. ..

Background Colar. .

Select Scanner...

Checking print job status

You can check the status of a job that has been submitted to the Infoprint server for printing. After
you have submitted a job:

1. Click Options in the menu bar, then click Print Job Status.

2. Inthe Job Status dialog box, you can view the job ticket, view the job messages returned
from the server, delete a job from the status list, or cancel the print job. You can also refresh
the status list. For more details, go to Job Status.

Job Status EHE

| Cuztamer | Status | Copies
Pending at server 1 Wiew Ticket...

Meszages...

Delete

EllE

Cahcel Job

Cloze | Refrezh | Help |

e View information about the print job in the display area.
Go to "Display Areal' on page 51 for information.

e Perform actions using the command buttons.
Go to "Command Buttons|' on page 51|for information.

3. Click the Close button to close the Job Status dialog box.

Note: Job status is available while this Infoprint Scan session is open, for jobs submitted during
this session. If you close and reopen the Scan session, the job status dialog box is
cleared.
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Display Area

Job status dialog box - Displays the name of the job ticket that was submitted, the customer
name, the status, and the copies to print value. Job states reported here include:
— Canceled

— Completed (reported for any jobs that are no longer at server)

— Held at server

— Imposing at server

— Interrupted at server

— Paused at server

— Pending at server

— Preprocessing at server

— Printing at server

— Processing at server

— Ripping at server

— Saved at server (retained at server)

— Sending

— Terminating

— Timed-out at server

Tip: You can change the width of a column by dragging the edge of the column heading to the

right or left. To make the column wide enough to display all current entries, double-click on
the right edge of the column heading.

Command Buttons

View Ticket... - click to open the Job Ticket window to view the formatted job ticket for the
selected job.

Messages... - click to open the Job Messages window to view job status messages returned
from the server for the selected job.

Delete - click to delete the selected job from the job status list.
Cancel Job - click to cancel the selected job.

Note: Only active jobs can be canceled; jobs whose status are Completed cannot be
canceled.

Refresh - click to query the status again and refresh the list to display current status of jobs
and status of any newly submitted jobs.

© Copyright IBM Corp. 1999 51



Export an Infoprint Scan document as a PDF file

You can use Infoprint Scan's Export function to save an entire Infoprint Scan document, including
the job ticket and all associated TIFF files, as a single PDF file that can be viewed online or
printed.)

To export an Infoprint Scan document as a PDF file:

1. With a scanned document open and displayed in the Infoprint Scan main window, click
File in the menu bar and then click Export....

(Z=W Edit PFPage “iew T

HEw.. [t
Een,.. [EEr{+ 0
Cloze

Scan...

Bemowve...

Submit Job... Chl+d
Frirt.... Chrl+F

E xit
2. Inthe Export pages to one file dialog box:

Export pages to one file: |

) Curent page
) Fages |

& Document

Browse. .. | C:hScanhScan stuffstestit pdf

¥ | St b Hites Libran:

|FOF x| [Binaw x| JoomTes #]

k. [ | Cancel |

e The Document radio button is selected, and the Current Page and Pages radio
buttons are grayed out.

e The name and where the file will be saved is displayed to the right of the Browse...
button. To change this name and/or location, click Browse....
a. Inthe Open dialog box, specify a new name and/or location for the file.
b. Inthe List Files of Type field, select PDF(*.pdf).
c. Click Open to return to the Export Pages to One File dialog box.
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Lookin: | =3 Soan stlf

File narme; C:hScantScan stufftestit pdf Open
Files of type:  [POF [+ pal] | Caricel |

3. Inthe Export pages to one file dialog box, in the field in the lower left, select the PDF file
format.

The field in the lower center displays the color format. The only valid choice is Binary.
The field in the lower right displays the compression type. Select CCITT G4.
Click OK to save the file.

Now you can:

e Store the PDF file

e Send the PDF file to someone else

e Launch Adobe Acrobat Reader to view and print the PDF file

e Launch the IBM Infoprint 2000 Print File Downloader to print the PDF file on an
Infoprint 2000

N o g &
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PDF files

PDF (Portable Document Format) is the file format used by Adobe Acrobat. PDF files contain a
very compact representation of text and graphics that enables documents with complete text and
graphics to be viewed and printed on DOS, Macintosh, Windows, and UNIX (AIX, SGI, SUN,
Solaris, and Linux) systems.

Benefits of exporting a Scan document as a PDF file

e A PDF file comes in handy if you need to send a final copy of a scanned document to another
location. For example, if a scanned document is not exported as a PDF file, the job ticket for
a 100-page scanned document will include 100 individual TIFF files that you have to keep
track of and send. An exported PDF is a single file which contains the job ticket and all
associated TIFF files.

e The PDF file can be viewed online and printed using the Adobe Acrobat Reader, or you can
use the functions of the Infoprint 2000 Print File Downloader to print the PDF file on an
Infoprint 2000.

e The following information may be of assistance when you are deciding whether to use local
printing or to export a scanned document as a PDF file:

— Some local print drivers impose restrictions that can be avoided if you print a PDF file. For
example, the Infoprint 2000 PCL driver has a 1/4-inch restriction on printing to the edge
of a sheet of paper. If this is a problem for a particular job, export and print the job ticket
as a PDF file.

— A PDF file is more efficient with space and performance than PCL when you print large
Scan jobs (over 100 pages). PCL does not use image compression. Since PDF images
are compressed, they use less space on your system, and transfer time is shorter.

— For less demanding jobs, local PCL printing uses a simpler workflow. Though the workflow
includes additional steps for export, you'll do better with PDF files for larger, more
complex jobs.
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Zoning pages in an Infoprint Scan document

The following procedures are applicable only when you are using the Infoprint Scan standard
interface. If it is available with your version of Infoprint Scan and you want to use the alternate
copier interface, refer to "Using the Infoprint Scan Copier interface! on page 119|for information.

You can use the manual zoning functions to rescan a selected part of a page at different scanner
settings than the rest of the page. For example, on a page that contains a combination of text and
a halftone, you can specify a zone for the halftone and increase the contrast or sharpness of the
halftone image within the zone.

When a zoned area is rescanned, the result is a rectangular area called a layer. After you have
created such layers, you can find additional information about working with the layers in
"Modifying layers with Infoprint Scan' on page |95

Note: The zoning functions will only be available in the Page menu or in the tool bar when your
workstation is attached to a scanner that supports manual zoning.

To use the zoning functions:
e You can use either the options in the Page menu:

(G0N “iew Tools
Add...

Save bz
Delete
Have

Zone Settings g

Bemove Zone

Bescan...

or

¢ You can use the zoning tools from the tool bar:

ﬁl Zoning Tool - use to define a zone that you want to scan differently than the rest of the
page.

Igl Undo Zone - cancels the last zone you defined.
Iél Rescan Page - scans the page again using different settings for different zones.

Is_l Zone Settings - use to view and/or modify the scanner settings for currently defined
zones.

The following procedures are described:

e "Zoning a page' on page 56

e "Selecting scanner settings for zoned areas|' on page 59

e "Viewing or modifying settings for a defined zone'' on page |60
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Zoning a page

To zone a page of an Infoprint Scan document you must have the document open to the page
that you want to zone.

Note: A page must first be scanned without zoning before you can zone the page.

Once a page has been scanned, you can:

e Zone and rescan a page while a new document is still open immediately after scanning.

e Open a previously scanned document to zone and rescan a page.

e Open a previously scanned document and append a new page that you will then zone and
rescan.

To zone a page:

1. Use the buttons on the tool bar or the available options in the View menu make the page that
you want to zone the currently displayed page. (See "Navigating through an Infoprint Scan
document" on page 115 for information.)

2. Place the hardcopy page on the scanner, exactly as it was placed when it was originally
scanned.

3. To define a zone:

¢ Click the Zoning Tool button ~4| on the tool bar,
or
e C(Click Page in the menu bar, and then click Add Zone.

(G0N “iew Tools
Add...

Save bz
Delete
Have

Zone Settings g

Bemove Zone

Bescan...
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A cross hair cursor will be displayed.
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4. Position the cursor and hold down the left mouse button as you move the cursor to define a
rectangular zone. When the rectangle encloses the zone, release the left mouse button.

& InfoPrint Scan - [Fone5amp.jtk : Page 3 of 4]
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The Zone Scan Settings dialog box will open.

Note: Once you release the left mouse button, you will not be able to adjust the size of the
rectangle. To change the size of a zone, you need to delete the zone:
e Click the Undo Zone button in the tool bar
or
Click Page in the menu bar, and then click Remove Zone

e Begin again.

In the Zone Scan Settings dialog box, click the Change Settings button to specify the

scanner settings for this zone.
The Mode, Resolution and Original Size fields cannot be edited in the Zone Scan Settings
dialog box. These fields reflect the options you select for scanner settings.

Zone Scan Setings |

— Ophions
Change Settings
b ode:; GrayScale - 256 levels

Original Size : Letter - 3.5 % 17 inches
Rezolution : 200 dpi

k. Cancel Reszcan

For more information, see "Selecting scanner settings for zoned areas|' on page |59.

When you have finished defining the settings for the current zone, click Rescan in the Zone
Scan Settings dialog box.

When the zone has been rescanned, if you want to define one or more additional zones, click
OK. Use the zoning tool again to define another zone and repeat steps 1 through 6 for each
additional zone.

When you have finished defining and rescanning all zones, click OK to return to the open
document and save your zone settings for the current session only.
(Click Cancel to return to the open document without saving your settings.)

When you have finished with the document:
e Click File in the menu bar, and then click Close to close and save the open document.

or
o Click File in the menu bar, and then click Exit to close and save the open document and

exit the Infoprint Scan program.

Note: When you rescan a zone, be sure to use:
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the Rescan button in the Zone Scan Settings dialog box
or

— the Rescan page button |é| on the toolbar.
or
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— the Rescan... option in the Page menu.

[SENEN Wiew  Tools
Add...

Save Az
Delete
Save

Add Zone
£one Settingz
Bemove Sone

Thh |

Do not use the Scan option in the File menu to rescan a zoned page, because the
zone(s) will not be recognized and you will rescan the page using the same settings
across the entire page.

Selecting scanner settings for zoned areas

Every scanner is different and has its own settings that control how pages will be scanned.
Infoprint Scan supports the industry standard ISIS scanner drivers that are provided by the
scanner manufacturers. These drivers provide default scanner settings based on standard types
of hardcopy originals. You can use the default settings or you can modify the settings as
necessary to get the best quality output.

To view or modify scanner settings:
1. Click the Change Settings button in the Zone Scan Settings dialog box.

2. Inthe Scanner Settings dialog box:
a. Modify the settings as appropriate, or use the default settings.
b. To view or modify additional, advanced settings, click the More... button.
c. Modify the advanced settings as appropriate, or use the default settings, then click the
OK button.
d. When you are done, click the OK button in the Scanner Settings dialog box.

If you need assistance understanding and using the available scanner settings:

e For an explanation of the settings that can be specified for the Xerox Doculmage 620S
scanner, refer to the following topics in the "Setting up the scanner|' section of this document:

"Xerox Doculmage 620S scanner settings' on page 16
"Xerox Doculmage 620S advanced scanner settings!' on page 19

e For information about the settings that can be specified for any other scanner, refer to the
documentation provided by the manufacturer of your scanner.
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Viewing or modifying settings for a defined zone

After you close a document containing a page or pages that you have zoned, the zone settings
are saved for the current Infoprint Scan session only. You can close and then reopen a document
to further modify the zone settings for a page or pages, as long as you have not exited Infoprint
Scan since defining the zones. The original settings for zones are restored at the start of every
Infoprint Scan session.

To view or modify the settings for previously defined zones:
1. Open the Scan document that contains the defined zone(s).

2. Use the buttons on the tool bar or the available options in the View menu make the page that
contains the zone(s) you want to view or modify the currently displayed page. (See
"Navigating through an Infoprint Scan document” on page|115 for information.)

3. Place the corresponding hardcopy page on the scanner, exactly as it was placed when it was
originally scanned.

4. To open the Zone Scan Settings dialog box, click on to select the defined zone and then:

e C(Click the Zone Settings button |5_| on the tool bar.
or

¢ C(Click Page in the menu bar, and then click Zone Settings.
(DN iew  Tools
Add...

Save bz
Delete
Have

Add Zone

Zone Settings k
Bemove Zone
Bezcan...

Notes:

e When a zone is selected, it displays with a broken outline.

¢ Double-clicking on the defined zone will also open the Zone Scan Settings dialog box
for that zone.

5. Inthe Zone Scan Settings dialog box, click the Change Settings button to view or modify the
scanner settings for the selected zone.
The Mode, Resolution and Original Size fields cannot be edited in the Zone Scan Settings
dialog box. These fields reflect the options you select for scanner settings.

For information about setting the scanner, see "Selecting scanner settings for zoned areas/
on page 59.
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Zone Soan Settings |

— Optionz
Change Settings
b ode: GrayScale - 256 levels

Original Size ; Letter - 8.5 % 171 inches
Reszolution : 200 dpi

aF. Cancel Rescan

6. When you have finished viewing or modifying the settings for the selected zone, to rescan the
zone with the new settings, click Rescan in the Zone Scan Settings dialog box.

7. When the zone has been rescanned, if you want to view or modify the settings for one or
more additional zones, click OK and repeat steps 2 through 6 for each additional zone.

8. When you have finished viewing, modifying, and rescanning the defined zones:
e Click File in the menu bar, and then click Close to close and save the open document.
or
o Click File in the menu bar, and then click Exit to close and save the open document and
exit the Infoprint Scan program.

Note: When you rescan a zone, be sure to use:
the Rescan button in the Zone Scan Settings dialog box
or

— the Rescan page button |é| on the toolbar.
Or
— the Rescan... option in the Page menu.
S0l View  Tools
Add...

Save bz
Delete
Have

Add Zone
Zone Sethings
Bemove Zone

Thh |

Do not use the Scan option in the File menu to rescan a zoned page, because the
zone(s) will not be recognized and you will rescan the page using the same settings
across the entire page.
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Aligning pages in an Infoprint Scan document

The following procedures are applicable only when you are using the Infoprint Scan standard
interface. If it is available with your version of Infoprint Scan and you want to use the alternate
copier interface, refer to "Using the Infoprint Scan Copier interface! on page 119|for information.

When you scan a document, each page may not come out perfectly centered and aligned with
the pages that precede and follow it. This can be particularly obvious when you scan and then
print a duplex document. You can use the Page Alignment function to align pages on a common
reference point, such as a page number.

The following page alignment tools are provided in the tool bar:
El Inches/Centimeters - toggles the rulers along the top and left side of the current page

among three states: inches, centimeters, and not displayed. The rulers are useful for setting
the position of the reference point on which pages will be aligned.

Iﬁl Move page - moves the page in relation to the cross hairs.

ﬁl Undo alignment - undoes all of the alignment actions performed on the current page only. If
you have made changes to more than one page, you must undo changes made to each
page individually.

Iil Set reference - provides a cursor used to display or move cross hairs.

Tip: To deselect the Set Reference or Move Page tool, click the Pointer tool El
The following tools that may be used with page alignment are also provided in the tool bar:
Copy changes - copies the alignment reference point for the current page, as well as other

page editing changes, to another page or pages.
(See "Copy changes vs Copy button" on page|113|for related information.)

Iﬂl Save changes - saves the page alignment and any other editing (such as, add text, erase,
cut, copy, paste) done to all pages in the document.

Aligning pages

To align the pages in an Infoprint Scan document, Infoprint Scan must be started and the
document needing alignment must be open.

1. Use the buttons on the tool bar or the available options in the View menu to make a particular
page the current page. (See "Navigating through an Infoprint Scan document” on page 115
for information.)

Note: For best results, maximize the display window when using Page Alignment. If
necessary, use the Zoom button on the tool bar to zoom in so you will have a closer
view of the area you are working on. (See "Zooming| on page (115 for information.)

2. Click the Inches/Centimeters button El until the rulers display in the unit you prefer: inches
or centimeters.
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3. To set the alignment for the currently displayed page:

a. Click the Set Reference button |i|
A cross hair cursor will be displayed.

b. Hold down the left mouse button to move the cursor to position the cross hairs where you
want them on the page. The placement of the cross hairs will determine the position of
the reference point on which to align the page.
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c. When the cross hairs are positioned, release the left mouse button.
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Click and hold down the left mouse button again to move the cursor and position a
second set of cross in the opposite corner of the page.
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Click the Move page button and hold down the left mouse button to move the page in
relation to the cross hairs.

or

You can also move the page in relation to the cross hairs by using the arrow keys on your
keyboard, allowing more precise positioning.
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If you're using the Move Page tool, when the page is in the correct position for alignment,
release the left mouse button.

4. To set the alignment for additional pages, use either of the following methods:

a.

b.

To set the alignment for other pages individually, repeat step 4 for each page needing
alignment.

Or

To copy and use exactly the same changes made on the current page to another page or

pages, click the Copy changes button .

(Do not confuse the Copy changes button with the Copy button, as they are very similar.
See "Copy changes vs Copy button|' on page (113 for additional information.)

5. Click the Save changes button |E| in the tool bar to save your alignment settings.
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6.

Click Yes in the message box when prompted.

InfoPrint Scan |

& Save changes to pages in your dacument ?
|

7. When you are finished using the Page Alignment function, click View in the menu bar and

8.

66

then click Display Reference Mark to turn off the cross hairs.

Toolz Option:  Help

Scale... »
MHest Page Foln
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Last Page End

Go ToPage... Chl+z

Dizplay Reference b ark.

When you have finished with the open document:

a. Click File in the menu bar, and then click Close to close and save the open document.

or

b. Click File in the menu bar, and then click Exit to close and save the document and exit

the Infoprint Scan program.
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Erasing areas from pages in an Infoprint Scan document

The following procedures are applicable only when you are using the Infoprint Scan standard
interface. If it is available with your version of Infoprint Scan and you want to use the alternate
copier interface, refer to "Using the Infoprint Scan Copier interface! on page 119|for information.

To erase areas of a page, you can use either of the following:

e The options in the Tools menu:

QGG Options  Help
Enhance. ..
Benumber Fages

IInda Eraze
Add Tenxt. ..
[yl Tiewt

LCopy Changes

or
e The erase tools from the tool bar:

Iﬁl Erase region - provides a cursor you can use to define an area or region that you want
to delete from the page.

EI Undo Edit - undoes a selected erasure or the last erasure performed on the current
page only. If you have made erasures on more than one page, you must undo the
erasures made on each page individually. Erasures cannot be undone after you have
saved your changes. (This tool also undoes a selected cut or the last cut done on a

page.)

Tip: To deselect the Erase region tool, click the Pointer tool El

The following tools that may be used with erasing are also provided in the tool bar:

Copy changes - copies the erasing done to areas on the current page, as well as other
page editing changes, to another page or pages. (See "Copy changes vs Copy button on
page 113 for related information.)

Iﬂl Save changes - saves the erasures and any other editing (such as, add text, page
alignment, cut, copy, paste) done to all pages in the document.
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Erasing

To erase areas from pages in an Infoprint Scan document, Infoprint Scan must be started and the
document needing erasures must be open.

1.

4.
5.

68

Use the buttons on the tool bar or the available options in the View menu to make a particular
page the current page. (See "Navigating through an Infoprint Scan document" on page 115
for information.)

Note: For best results, maximize the display window. If necessary, use the Zoom button
on the tool bar to zoom in so you will have a closer view of the area you are working
on. (See "Zooming" on page [115/for information.)

To delete an area of the currently displayed page:

e Click the Erase region button |£| in the tool bar.
or

e Click Tools in the menu bar and then click Erase Region.

A cursor - will be displayed.

Position the cursor and hold down the left mouse button as you move the cursor to define a
rectangular area containing the part of the image you want to erase.

= Dial hardware and software services with a single phone number
*  Clesn up and align seanned images for printing

+ Fome pages avtomatically using the solution-integrated Xerox Doculmage 6208 or
Ricoh IS 420 (with IBM's exclusive imige enhancement) scanner

+ Save scanned files as PDF source for viewing, printing, and distribution on the Web

A local press repubilishes out-of-print books. With the Xerox Doculmage 6208, they can scan

fragile originals—even large-format picture books. With Infopring Scan software, they erase the

comments fnked in the margin in 1923 and collate pages from two incomplete copies to recreats

;ﬁ%ﬁﬂ image of the first edition. Customers can link o sample chapters from their catalog on
b,

When the unwanted data is no longer visible, release the left mouse button.
Repeat steps 3 and 4 for each area on the page that needs to be erased.

Tip: To deselect the eraser, click the Pointer button in the toolbar.
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6. After you have defined a rectangular area to erase, and before you save your changes, you
can change the position of the erasing rectangle. Position the pointer over the rectangle and
hold down the left mouse button as you move the rectangle to its new location.

= Dial hardware and sofiware services with a single phone nomber
*  Clean up and align scanned Images for printing

s Fone pages antomatically using the solution-integrated Xerox Doculmage 6205 or
Ricoh IS 420 (with IBM's exclusive inuge enhancement) seanner

+ Save scanned files as PDF source for viewing, printing, and distribution on the Web

&0

oot

IntaPrId et BUbl of Bims | |

L ET

A local prass republishes out-of-print books. With the Xerox Doculmage 6208, they can scan

fragile origials—even Jarge-format picture bocks. With Infoprint Scan softwar, they erase the

commenis nked in the margin in 1923 and collate pages. from two incomplete copies o recreats

;:E:"‘Iléﬂ image of the first edition. Customers can link io sample chapters from their catalog an
'eb,

7. When the rectangle is in its new position, release the left mouse button.
8. To erase areas on additional pages, use either of the following methods:

a. To erase areas on other pages individually, repeat steps 1 through 4 for each page that
needs erasures.
or

b. To copy and use exactly the same erasure done on the current page to another page or
pages, click the Copy changes button.
(Do not confuse the Copy changes button with the Copy button, as they are very similar.
See "Copy changes vs Copy button|' on page [113/for additional information.)

Note: You can use the Undo Edit button EI to undo erasures before you save your
changes:
e Click the Undo Edit button to undo the last erasure done on the current page
(you can do this multiple times).
or

e Click the Pointer tool El and select a specific erased area, then click the
Undo Edit button. (When an area is selected, it has a broken outline.)

After you have saved changes, none of your erasures can be undone.

9. Click the Save changes button |E| to save your changes.
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10. Click Yes in the message box when prompted.

InfoPrint S5can |

& Save changes to pages in your dacument ?
N we |

11. When you have finished with the open document:

¢ Click File in the menu bar, and then click Close to close and save the open document.

or

¢ (Click File in the menu bar, and then click Exit to close and save the document and exit

the Infoprint Scan program.
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Adding text and page numbers to pages in an Infoprint
Scan document

The following procedures are applicable only when you are using the Infoprint Scan standard
interface. If it is available with your version of Infoprint Scan and you want to use the alternate
copier interface, refer to "Using the Infoprint Scan Copier interface| on page [119 for information.

You can add, edit, format, move, and copy text on any page of an Infoprint Scan document. You
can also add single or consecutive page numbers.

To add text and page numbers to a page, you can use either of the following:
e The options in the Tools menu:

G Options:  Help

Enhance. ..
Benumber Pages

Eraze Region
[hdo Erase

IIndo Text E!

Copy Changes

or

e The text tools from the tool bar:
Iil Add Text - provides a cursor used to define the area for adding text.

Iél Undo Text - removes a selected text area or the last text area added to the current
page. If you have added text to more than one page, you must undo the text added to
each page individually. Added text cannot be undone after you have saved your
changes.

The following tools that may be used when you are adding text are also provided in the tool
bar:

Copy changes - copies the text added to the current page, as well as other page

editing changes, to another page or pages. (See "Copy changes vs Copy button’ on
page [113|for related information.)

Iﬂl Save changes - saves the added text and any other editing (such as, page alignment,
erase, cut, copy, paste) done to all pages in the document.

Adding text
To add text to a page:

1. Use the buttons on the tool bar or the available options in the View menu to make a particular
page the current page. (See "Navigating through an Infoprint Scan document” on page 115
for information.)

2. Click the Add Text button |ﬁ|
or
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Click Tools in the menu bar and then click Add Text....

I EN Option:  Help

Enhance...
Benumber Pages

Eraze Region
[ ade Erase

e |

s [ =

[Eapy Ehanges

A cursor - will be displayed.

Position the cursor and hold down the left mouse button as you move the cursor to define a
rectangular area where you want to enter text. When the box is the right size and shape,
release the left mouse button.

& InfoPrint S5can - [foneSamp.jtk : Page 6 of 6]

File Edt Page “iew Toolz Optionz Help

~ 1
L J
Hard Copy Scanning

Hard copy used io be the end of the print process. Make if the beginning with
InfaPrini...

Highlights

* Take advantage of the IBM Infoprint Scan Integrated solution, which combines
bardware and software in a single system

= Dial hardware and software services with a single phone numiber
#  Cléan up and align scanned Images for printing

Note: Once you have released the left mouse button, you cannot resize the text box. If you
size the box incorrectly, you will have to delete the box and begin again.
(See "Removing text" on page 75 for information about deleting text boxes.)
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4. Inthe Adding Text dialog box, select the text alignment: L (left), C (center), or R (right).

Adding Text =
—ngl C | . | - | Far: Tiies s Bewmen
Size: 12
" 3
=
ok | Cancel | Aocly | ™ hep |

5. Click the Font button to select the font settings for the text you want to add.

Font |

Eant: Font style:
il Bold | ok %J
A5 aramaond il R eqular
T Allegro BT ltalic Ezinzel |
T AmerType MdBT
W Bo lae
Arial Black
T Avial Marmow
W AvantGarde Bk BT 7]
— Effectz —Sample
[ Strikeout
[ Underline AﬂBbezz
Calar;
I- Black ;l Script:
I'W'estern ;I

Thiz iz a TrueT ype fant. Thiz zame font will be uzed on both
wour gcreen and pour printer.

6. When you have selected the settings, click the OK button to return to the Adding Text dialog
box.
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7. Enter the text in the space provided.

Adding Text ]|
L | C | R | Fant | Fant: Arnial
Size: 14
First Edition, 5pring 1999 =]
ak. Cancel | Apply E |

Tip: To find out how to add page numbers here, go to 'Adding page numbers|' on page 76.
8. Click the Apply button.

The text appears at the top of the text box that you defined earlier.

& InfoPrint Scan - [foneSamp.jtk : Page 6 of 6]

File Edit Page “iew Toolz Option: Help

ole| gl glm|m] &alk]c|=|»l| s|alx|e|#] wle]]|+

First Edition, Spring 1999 |

Hard Copy Scanning

Hard copy used iv be the end of the print process. Make it the beginning with
InfoPrint...

Highlights

» Take advantage of the IBM Infoprint Scan Integrated sohution, which combines
hardware and software in a single system

* Dial hardware and sofiware services with a single phone number
#  Clean up and align scanned Images for printing

9. When you have finished entering the text, click the OK button.
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10. After you have added a text box, and before you save your changes, you can change the
position of the text box. Position the pointer over the text box and hold down the left mouse
button as you move the box to its new location.

& InfoPrint Scan - [foneSamp.jtk : Page b of 6]

File Edit Page “iew Toolz Optionz Help

Ble|elElm|m| alalk]c|=|#1| o|alx|e|z] wl@m|p|+]

First Edition, Spring 1999 |

—_— _—

Hard Copy Scanning

Hard copy used fo be the end of the prins process. Make it the beginning with
InfoPrint...

Highlighis

* Take advantage of the IBM Infoprint Scan Integrated solution, which combines
bardware and software in a single system

* Dial hardware and software services with a single phote number
#  Cléan up and align scanned images for printing

11. When the text box is in its new position, release the left mouse button.

12. To add text to additional pages, use either of the following methods:
a. To add text to other pages individually, repeat steps 1 through 9 for each page where you
want to add text.
or
b. To copy and use exactly the same text added to the current page to another page or

pages, click the Copy changes button .
(Do not confuse the Copy changes button with the Copy button, as they are very similar.
See "Copy changes vs Copy button|" on page [113/for additional information.)

Removing text
You can remove added text before you save your changes:

e Click the Undo Text button Iél to remove the last text that you added (you can do this
multiple times).
or

e C(Click the Pointer button El and select a specific text box, then click the Undo Text
button. (When a text box is selected, it has a broken outline.)

Editing text

You can also edit the text in a text box before you save your changes:
a. Position the pointer over the text box you want to edit.
b. Double-click the left mouse button.

c. Repeat any of steps 4 through 9 that are necessary. Each time you click the Apply
button, your changes appear in the defined text box.

d. When you have finished editing the text, click the OK button to return to the open
document.
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13. When you have finished adding and editing the text, click the Save changes button Ein the
tool bar to save the text.

Note: After you have saved changes, the added text cannot be edited or undone.

14. Click Yes in the message box when prompted.

InfoPrint Scan |

& Save changes to pages in your document ?
No |

15. When you have finished with the open document:
e Click File in the menu bar, and then click Close to close and save the open document.
or
e Click File in the menu bar, and then click Exit to close and save the document and exit
the Infoprint Scan program.

Adding page numbers

To add a page number to a page in an Infoprint Scan document, follow the general instructions
for "Adding text" on page 71, except:

e After you've defined a text box in the size and position where you want to place the page
number, enter the following string in the Adding Text dialog box to add a number that
corresponds to the number of the current page:

%%N0
Don't forget to specify the font settings you want to use for the page number.

The 0 (zero) specifies that you want to use the actual number of the current page.

Example
If you are on the first page of the document, and want to add the string Page 1 at a defined
location on the page:

1. Type the following in the Adding Text dialog box:
Page %%N0
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2. Click the Apply button to see "Page 1" appear in the defined text box.

gl Adding Text

L|I:|Fi| Font |

Font; Times Mew Foman
Size: 12

Page xNO|

Cancel

Apply M

=

:

E;e*l

Ready

Every semester, 4 professor updates & customized course texibook. The reproduction center at
the local uriversity nses Infoprint Sean o scan in new jourmal articles, assemble them with
previously scanmed articles, replace the course schedule, and print just enough copies foe the students,

number of the current page plus or minus the number you enter.

— For example, if your document has some front matter and/or blank pages at the
beginning, and you want the 5th page to start numbering as Page 1, make the 5th page
the current page and type the following in the Adding Text dialog box:

Page %%N-4

The number at the end of the string specifies that you want to start numbering with the

— For another example, if you're on the first page of a document, but want the numbering

on that page to start at 4, type the following in the Adding Text dialog box:

%%N3 or %%N+3

To add consecutive numbers to additional pages, click the Copy changes button to open

the Copy Page Changes dialog box. Here you can specify to copy the text box with your page
numbering notation to the entire document, to odd or even pages, or to a list or range of

pages in the document.

Important: If you have added page numbering (or any other changes) you will be prompted to
save the changes to the document before you can continue with additional
scanning. Therefore, be sure that you have scanned all pages and verified the order
of pages in a document before you add, copy, and save page numbering. Once
page numbering has been saved, the numbering will not be updated if you insert

additional pages.
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Resizing images in an Infoprint Scan document

The following procedures are applicable only when you are using the Infoprint Scan standard
interface. If it is available with your version of Infoprint Scan and you want to use the alternate
copier interface, refer to "Using the Infoprint Scan Copier interface! on page 119|for information.

You can resize the image on a page, selected pages, or all of the pages in an Infoprint Scan
document. Resizing the image on a page will permanently change the image. After resizing, you
will not be able to return the image to its original size.

To resize images and pages in an Infoprint Scan document, Infoprint Scan must be started and
the document needing resizing must be open.

To resize images and pages:

1.

3.

Use the buttons on the tool bar or the available options in the View menu to make a particular
page the current page. (See "Navigating through an Infoprint Scan document" on page 115
for information.)

Click Edit in the menu bar and then click Resize Image...
Page “iew Toolz Opt

Cuat Chrl-=

Copy Chil-C
Easte B
[ Caper

fllatke Layern Iransparent
[Nesereer [Laper

Saereem Laper

[ et Layer

Histogram Streteh...

Crop...

Resize Image...

In the Resize Images dialog box:

a. Select the appropriate radio button to specify that you want to resize just the currently
displayed image (page), a range of pages, or every page of the document.
When you select Range of Pages, the Range field will become available, where you can
enter which pages you want to resize. Here you can type:

the number of each page, separated by a comma (for example: 2,10,26,40)
or

the beginning and end of a range of pages, separated by a hyphen

(for example: 13-15)

or

a combination of both (for example: 1-4,10,15,18-23).

Note: Do not include spaces after the commas.

b. You now have two choices:

You can scale the page and image proportionally, preserving the aspect ratio of both.
(See Figure 2/on page 81))

or

You can resize the page to specified dimensions without changing the size of the
image on the page. (See Figure 3 on page 82.)
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To resize the page and image, preserving the aspect ratio:

Be sure to select (check) the Scale to fit finished page size check box. This is very
important!

When you know the finished size that you want for the width of the page, you can let
Infoprint Scan figure the correct size for the height.

For example, for a finished page width of five inches:
— Type 5 in the Width field.
— Type 0 in the Height field.

Resize Images E

€ Cument Page  Range of Pages ' Document

Range: | i 1-4,10,15-20

width: |5 i
Height: ID

Finizhed Page Size:

¥ iScale to fit finished page size

" Simplex o N [ =
& Duplex acement; I I
QK l: I Cancel | Help |

For a finished page height of seven inches:
— Type 0 in the Width field.
— Type 7 in the Height field.

Resize Images

" Cument Page ¢ Range of Pages & Document
Range: | ie 1-4,10,15-20

width: [0 i
Height: |7‘|

Finished Page Size:

¥ Scale to fit finished page size

" Simplex
Placement: ICENEI vl
+ Duplex
w Cancel | Help |

Note: If you specify values for both width and height, and the values are not

proportional to the original size, and you also check the Scale to fit finished page
size check box, Infoprint Scan will use the value that you specified for the height,

ignore what you entered for the width, and will figure the value for the width in
proportion to your specified height.
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Figure 2. Scaling the page and image proportionally, preserving the aspect ratio of both.

To resize the page to exact, specified dimensions, without changing the image size:
o Type the new dimensions you want for both the width and height.
¢ Do not select the Scale to fit finished page size check box.

Note: Keep in mind that when the Scale fo fit finished page size check box is not
checked, only the page will be resized, not the image. Depending on the size and
shape of the original image and of the resized finished page, parts of the image
may be cut off, as shown in the example in Figure 3/ on page 82.

Resize Images E

€ Cument Page  Range of Pages ' Document

Range: | i 1-4,10,15-20

width: [ n
Height: I?

Finizhed Page Size:

[ Scale tofit finished page size

" Simplex Iﬁ
- |Upper Left -
& Duplex Flacement; |Hpp
EIKE I Cancel | Help |

e Use the Placement field to position the image on the resized page. Choices are
Center, Upper Left, and Upper Right.
— If you select Upper Left along with Duplex, the image will be positioned starting
in the upper left on odd pages, and the upper right on even pages.
— If you select Upper Right along with Duplex, the image will be positioned
starting in the upper right on odd pages, and the upper left on even pages.
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Figure 3. Resize the page to specified dimensions without changing the size of the image on the
page.

c. Select either the Simplex or the Duplex radio button, depending on whether you want
your output to be printed on just one side of a sheet of paper, or if you want the output
adjusted for printing on both sides of the paper.

4. Click the OK button to resize.

Remember!
Resizing will permanently change the image. You cannot undo the resizing of an
image.

5. When you have finished resizing, and are finished with the open document:
e Click File in the menu bar, and then click Close to close and save the open document.
or

¢ Click File in the menu bar, and then click Exit to close and save the document and exit
the Infoprint Scan program.
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Using Infoprint Scan cut, copy, and move functions

The following procedures are applicable only when you are using the Infoprint Scan standard
interface. If it is available with your version of Infoprint Scan and you want to use the alternate
copier interface, refer to "Using the Infoprint Scan Copier interface! on page 119|for information.

These procedures describe how you can cut, copy, and move areas of a page in an Infoprint
Scan document. When a cut or copied area is pasted onto a page, the result is a rectangular area
called a layer. After you have learned how to create these layers, you can find additional
information about working with the layers in "Modifying layers with Infoprint Scan" on page 95.

To cut, copy, and move areas of a page, you can use either of the following:
e The options in the Edit menu:

Eage Wiew Toolz Opt
Cut Tl |

Paste Chl- g

[ Caper

fllatke Layern Iransparent
[Nesereer [Laper

Saereem Laper

[ et Layer

Histogram Streteh...

Crop...
Fesize Image...

or

e Thetools in the tool bar:
E Cut - deletes a specified area from the current page, and places it on the clipboard.

|@ Copy - copies a specified area from the current page to the clipboard.
(See "Copy changes vs Copy button! on page 113|for related information.)

|E Paste - places the contents of the clipboard at a specified location in the current
Infoprint Scan document.

Note: The clipboard is a buffer where a cut or copied page area is stored. You can paste
the contents of the Infoprint Scan clipboard onto a page in an Infoprint Scan
document. Infoprint Scan uses an internal clipboard, not the Windows clipboard. You
cannot paste the contents of Infoprint Scan's internal clipboard into other
applications, nor can you paste the contents of the Windows clipboard into an
Infoprint Scan document.

Iﬁl Undo Edit - undoes a selected cut or the last cut performed on the current page only. If
you have deleted areas on more than one page, you must undo the deletions made on
each page individually. Cuts cannot be undone after you have saved your changes.
(This tool also undoes a selected erasure or the last erasure done on a page.)
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The following tools that may be used when you cut, copy, and move are also provided in the tool
bar:

Copy changes - copies the editing done to areas on the current page to another page or
pages. (See "Copy changes vs Copy button on page (113 for related information.)

|E| Save changes - saves the editing and other changes (such as, add text, zoning, or page
alignment) done to all pages in the document.

Tips:

e To deselect the Cut tool or the Copy tool, click the Pointer tool E

e Use the buttons on the tool bar or the available options in the View menu to make a particular
page the current page. (See "Navigating through an Infoprint Scan document" on page 115
for information.)

e For best results, you may want to maximize the display window. If necessary, use the Zoom
button on the tool bar to zoom in so you will have a closer view of the area you are working
on. (See '"Zooming" on page [115/for information.)

To cut, copy, and move areas on pages in an Infoprint Scan document, Infoprint Scan must be
started and the document needing these editing operations must be open.
Then, to find out how to:

o delete an area from a page, see "Cut" on page 184

e duplicate an area, see "Copy'' on page 87

e move an area to a new position on the same page or on a different page, see "Move" on
page 90

Cut

To cut or delete an area of the currently displayed page:

1. Click the Cut button E in the tool bar.
or
Click Edit in the menu bar and then click Cut.

I Pooe View Took Options

ml
Copy Cirk-C

Fase

Crgp...
Besize Image...

A cursor - will be displayed.
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2. Position the cursor and hold down the left mouse button as you move the cursor to define a
rectangular area containing the part of the image you want to delete.

i InfoPrint Scan - [ZoneSamp.jtk : Page 8 of 9]
File Edit Page Wiew Tools Options Help

c|elelalnlal @lalklc|» (x| slalxe|z] wlnl@]+] xlxals | o
¢ Dial hardware and software services with a single phone nllmbeld

¢ Clean up and align scanned images for printing

* Zone pages automatically using the solution-integrated Xerox Dc
Ricoh IS 420 (with IBM's exclusive image enhancement) scanner

e Save scanned files as PDF source for viewing, printing, and distr

A local press republishes out-of-print books. With the Xerox Doculmage 62(
fragile originals--even large-format picture books. With Infoprint Scan soft
comments inked in the margin in 1923 and collate pages from two incomplet

3. When the area is defined, release the left mouse button.

& InfoPrint Scan - [Zone5amp.jtk : Page 8 of 9]
File Edit Page Miew Toolz Options Help

lelelanla| alalklc|»| slalx|o|z] ulm|+] wlpals | tolel
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To delete additional areas, use either of the following methods:

a. To delete individual areas on the same page or on other pages, repeat steps 1 through 3
for each area you want to delete.
or

b. To duplicate the same deleted area or areas from the current page on another page or

pages, click the Copy changes button.
(Do not confuse the Copy changes button with the Copy button, as they are very similar.
See "Copy changes vs Copy button|' on page [113/for additional information.)

Note: You can use the Undo Edit button @ to undo deletions before you save your
changes:

e Click the Undo Edit button to undo the last deletion done on the current page
(you can do this multiple times).
or

e C(Click the Pointer tool El and select a specific deleted area, then click the Undo
Edit button. (When an area is selected, it has a broken outline.)

Remember!
After you have saved changes, none of your cuts can be undone.

When you are finished deleting areas from pages in the document, click the Save changes
button Iﬁl to save the deletions and any other changes.

Click Yes in the message box when prompted.

InfoPrint Scan |

& Save changes to pages in your dacument ?
Ho |

When you have finished with the open document:

¢ Click File in the menu bar, and then click Close to close and save the open document.
or

e Click File in the menu bar, and then click Exit to close and save the document and exit
the Infoprint Scan program.
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Copy

To copy or duplicate an area of the currently displayed page:

1. Click the Copy button |@ in the tool bar.
or
Click Edit in the menu bar, and then click Copy.
Page “iew Toolz Opt
Cut Chlix |

Paste Chl k

Hrde Laper

fake Layen Transparent
[Nezmreer [Laver

Sareen Layer

[ et Cayer

Histagranm Stetet,.

Crop...

Rezize Image...

A cursor = will be displayed.

2. Position the cursor and hold down the left mouse button as you move the cursor to define a
rectangular area containing the part of the image you want to copy. When the area is defined,
release the left mouse button.

& InfoPrint Scan - [ZoneSamp.jtk : Page 8 of 9] =l E3
File Edit Page “iew Tools Optionz Help
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¢ Clean up and align scanned images for printing

* Zone pages automatically using the solution-integrated Xerox D¢
Ricoh IS 420 (with IBM's exclusive image enhancement) scanner

¢ Save scanned files as PDF source for viewing, printing, and distr
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fragile originals--even large-format picture books. With Infoprint Scan soft
comments inked in the margin in 1923 and collate pages from two incomplei
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If you are copying the area to a different page, use the buttons on the tool bar or the available
options in the View menu to make the page to which you want to copy the area the current
page. (See "Navigating through an Infoprint Scan document” on page 115 for information.)

To paste the copied area onto the current page:
¢ Click the Paste button |E in the tool bar.
or
¢ Click Edit in the menu bar, and then click Paste.

Page ‘iew Took Opbone
Cust Cirled
CulC

[Pt ibaer

Crap...
Resize Image...

The copied area is pasted in the same position on the new page as it was on the original
page. (If you have copied the area onto the same page, the copied area is duplicated on
top of the original area.) Before you save your changes, you can still move the area to a
different location on the new page or on the original page. To do so:

a. Click the Pointer tool and place the pointer over the duplicate area.
b. Hold down the left mouse button, and drag the area to the new location.
c. When the area is in the correct position, release the left mouse button.

& InfoPrint Scan - [ZoneSamp.jtk : Page 5 of 9]
File  Edit

Fage “iew Toolz Options Help
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To duplicate the same copied area on additional pages, click the Copy changes button .

(Do not confuse the Copy changes button with the Copy button, as they are very similar.
See "Copy changes vs Copy button" on page|113 for additional information.)

To undo copied areas before you save your changes:

e Click Edit in the menu bar and then click Undo Layer to undo the last copy pasted onto
the current page.

Eage “Wiew Tools Opt
Cut Chrl=
Copy Chl-C
Pazte Chilt

b ake Layer Tran:parent
[Nezmreer [Laper

Sareen Layer

[t Layer

Histaaran Stretet,.

Crop...
Fiezize Image...

or

e Click the Pointer tool El and select a specific copied area, click Edit in the menu bar,
and then click Undo Layer. (When an area is selected, it has a broken outline.)

Remember!
After you have saved changes, you cannot undo any of your copies.

When you are finished copying areas in the document, click the Save changes button Iﬂl to
save the copies and any other changes.

Click Yes in the message box when prompted.

InfoPrint Scan |

& Save changes to pages in your document ?
Ma |

When you have finished with the open document:

o Click File in the menu bar, and then click Close to close and save the open document.
or

e Click File in the menu bar, and then click Exit to close and save the document and exit
the Infoprint Scan program.
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Move

To move an area of the currently displayed page to a new position on the same page or on a

different page:

1. Click the Cut button E in the tool bar.

or

Click Edit in the menu bar and then click Cut..
Page Wiew Took Opbons

Copy ! Cirk-C

Crgp...
Besize Image...

A cursor - will be displayed.

2. Position the cursor and hold down the left mouse button as you move the cursor to define a

rectangular area containing the part of the image you want to move.

& InfoPrint Scan - [ZoneSamp.jtk : Page 8 of 9]

File Edit Page “iew Tools

Options  Help

=1 E3

blelelalmla| @lali]c|sn slalxo]z] wlml]+] wlals | %o

90

A local press republishes out-of-print books. With the Xerox Doculmage 62(
fragile originals--even large-format picture books. With Infoprint Scan soft
comments inked in the margin in 1923 and collate pages from two incomplei

Dial hardware and software services with a single phone mlrnbel;I

Clean up and align scanned images for printing

Zone pages automatically using the solution-integrated Xerox Dc
Ricoh IS 420 (with IBM's exclusive image enhancement) scanner

Save scanned files as PDF source for viewing, printing, and distr
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3. When the area is defined, release the left mouse button.

& InfoPrint Scan - [ZoneSamp._jtk : Page & of 9] H=1E3
File Edit Page %iew Toolz Options Help
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¢ Clean up and align scanned images for printing

¢ Zone pages automatically using the solution-integrated Xerox D¢
Ricoh IS 420 (with IBM's exclusive image enhancement) scanner

¢ Save scanned files as PDF source for viewing, printing, and distr

A local press republishes out-of-print books. With the Xerox Doculmage 62(
fragile originals--even large-format picture books. With Infoprint Scan soft
comments inked in the margin in 1923 and collate pages from two incomplet

4. If you are moving the area to a different page, use the buttons on the tool bar or the available
options in the View menu to make the page to which you want to move the area the current
page. (See "Navigating through an Infoprint Scan document” on page 115 for information.)

5. To place the area on the current page:
¢ Click the Paste button |E in the tool bar.
or
e Click Edit in the menu bar and then click Paste.

Page ‘iew Took Opbone
Cust Cirled
Copy CulC

[y ertilarer

Crap...
Resize Image...

The area is pasted in the same position as it was on the original page. (If you are pasting on
the same page, the area is in its same position on top of the original area.)
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6. To reposition the area on the original page or on the page to which it was moved:

a. Click the Pointer tool El and position the pointer over the area.
b. Hold down the left mouse button and drag the area to its new position.

c. When the area is in the correct position, release the left mouse button.

& InfoPrint S5can - [ZoneSamp.jtk : Page 7 of 9]

File Edt Fage Miew Tools Options Help
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First Edition, Spring 1999
Hard Copy Scanning

Hard copy used to be the end of the print process. Make it the beginning with
InfoPrint...

Highlights

* Take advantage of the IRM Infoprint Scan integrated solution, which combines
hardware and software in a single system

* Dial hardware and software services with a single phone number
*  Clean up and align scanned images for printing

+ ZTone pages automatieally using the solution-integrated Xerox Doculmage 6208 or
Ricoh IS 420 (with IBM's exclogive image enhancement) scanner

Save scanned files as PDF source for viewing, printing, and distribution on the Web

-

A local press republishes out-of-peint books, With the Xerox Doculmage 6203, they can scan
fragile originals—even large-formit picture books. With Infoprint Scan software, they erase the
coffimets inked in the margin in 1923 and collpte papes from two incompleta copies 1o recreate

Notes:

e To undo cuts before you save your changes.

— Click the Undo Edit button EI to undo the last cut made on the current page (you
can do this multiple times).
Or

—  Click the Pointer button El and select a specific cut area, then click the Undo Edit
button. (When an area is selected, it has a broken outline.)
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e To undo pastes before you save your changes:

— Click Edit in the menu bar and then click Undo Layer to undo the last paste made on
the current page.

Eage Miew Toolz Opt
Cuat Chrl-=
Copy Chil-C
Paste Chl-

W
kdake Layer Tranzsparent
[Nesereer [Laper
Saereem Laper

[t Laper
Histogram Streteh...

Crop...
Fesize Image...

or
—  Click the Pointer tool El and select a specific pasted area, click Edit in the menu
bar and then click Undo Layer. (When an area is selected, it has a broken outline.)

Remember!
After you have saved changes, you cannot undo any of your moves.

When you are finished moving areas in the document, click the Save changes button |E| to

save your moves and any other changes.

Click Yes in the message box when prompted.

InfoPrint Scan |

& Save changes to pages in your document ?
M oW |

When you have finished with the open document:

o Click File in the menu bar, and then click Close to close and save the open document.
or

e Click File in the menu bar, and then click Exit to close and save the document and exit
the Infoprint Scan program.
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Modifying layers with Infoprint Scan

The following procedures are applicable only when you are using the Infoprint Scan standard
interface. If it is available with your version of Infoprint Scan and you want to use the alternate
copier interface, refer to "Using the Infoprint Scan Copier interface! on page 119|for information.

A layer is a rectangular area of a page that is created when a cut or copied area is pasted onto
the page from the Infoprint Scan clipboard or when a zoned area is rescanned.

FYIl: The Infoprint Scan clipboard is a buffer where a cut or copied page area is stored. You can
paste the contents of the Infoprint Scan clipboard onto a page in an Infoprint Scan
document. Infoprint Scan uses an internal clipboard, not the Windows clipboard. You
cannot paste the contents of Infoprint Scan'’s internal clipboard into other applications, nor
can you paste the contents of the Windows clipboard into an Infoprint Scan document.

For additional information about creating layers by cutting, copying, pasting, and zoning areas of
a page, refer to:

e "Using Infoprint Scan cut, copy, and move functions|' on page 83
e "Zoning pages in an Infoprint Scan document" on page 55

To modify a layer:

1. Select the layer you want to modify.

To select a layer, click the Pointer tool El in the tool bar, then position the pointer over the
layer and click the left mouse button. When a layer is selected, it displays with a broken
outline.

File Edt Page “iew Tools Options Help
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Note: When a layer is selected, you can reposition it on the page, if necessary. To do so,
place the pointer over the layer, hold down the left mouse button, and drag the area to
the new position.
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2. Click Edit in the menu bar, and then click one of the following:
Page iew Toolz Opt

Cut Chrl=
Copy Chl-C
Pazte Chilt

kake Layer Transparent
Descreen Laper

Screen Laper

[t Layer

Histagram Stretch...

Crop...
Fiezize Image...
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Undo Layer - Select this option to undo a selected paste or rescanned zone or the last of
these actions performed on the current page only. If you have pasted or rescanned
zoned areas on more than one page, you must undo these actions on each page
individually.

Make Layer Transparent - Select this option to eliminate the solid white background
from the image in a layer so that only the black part of the image is displayed and printed.
If the transparent layer is placed on top of another image or portion of an image on the
page, that image will show through from behind the layer.

mmn..u.ﬂ.wlr’m.--wﬂllif.'-lll-.:li.:.a-—l (v mpumsetiion: anduiions e
Uw::‘fun.inyre. Fravrdy
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Descreen Layer - Select this option to remove the halftone screen from a layer that
contains an image that was scanned as grayscale. This function is only available if you
have installed the Infoprint Scan Advanced features.

Screen Layer - Select this option to apply a halftone screen to a layer that contains a
continuous tone image or a grayscale image that has been descreened. This function is
only available if you have installed the Infoprint Scan Advanced features.

Using IBM Infoprint Scan



¢ Invert Layer - Select this option to reverse the black and white or grayscale image
contained in a layer so that all blacks are white and all whites are black. On a "positive"
image, the effect is similar to that of a photographic negative, as shown in Figure 4.
Conversely, a negative image is made positive.
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Figure 4. The image in a defined area of the page is inverted.

Note: This function works only on the image in a layer - if you want to reverse the
image of the entire page, use the Invert Image option on the Enhance Images
dialog box. For additional information, refer to page 33 of the "Enhancing images

in an Infoprint Scan document" topic.

Histogram Stretch - This option adjusts the contrast on a selected layer to improve the
appearance of a grayscale image. This function is only available if you have installed the

Infoprint Scan Advanced features.

FYI: A histogram looks at the range of tonal values in a grayscale image. The histogram
calculates the tonal values from dark to light, and figures the distribution of the relative
number of pixels at each level. These tonal values can be modified to change the level
and distribution of dark and light areas of an image, adjusting and improving the
relationship between the highlights, shadows, and midtones. If the histogram does not
cover the entire range from black to white, the image will not include both very dark or
black and very light or white areas. You can use the Histogram Stretch function to
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expand (stretch) the distribution of tonal values in an image so that they cover the entire
range from black to white.

In the Histogram Stretch dialog box:
a. Use the defaults, or modify these settings as required:

e Inthe Percent Black field, type the percentage of the image that you estimate
should be black.

¢ Inthe Percent White field, type the percentage of the image that you estimate
should be white.

e [f the image has a solid border around it, estimate the percentage of the image
taken up by the border, and type that value in the Ignore Border field. The white
or black pixels that make up the border will not be used when the percent of
white or black is calculated.

¢ Inthe Stretch Method field, select the method by which you want images to be
modified. Unless you are familiar with the various methods available, use LStar,
the default method, as it is appropriate for most images.

Histogram Stretch |

Percent Black: |2 i
Percent white: |2 4
|gnore Border: IEI] A

Shetch Method: ILStar "I

Eancell Help |

b. Click the OK button.

Tip: Unless you are very familiar with estimating and adjusting the percentages of
black and white in an image, you should begin by using the defaults, and then
make and compare additional adjustments in small increments until you achieve
the desired results.

When you are finished working with layers, click the Save changes button |E| in the tool bar
to save your modifications and any other changes you have made to the Scan document.

Note: Before you save your changes, be very sure that you have finished working with
all layers and any other defined areas. After you save changes to your Scan
document, you will no longer be able to select or modify a layer, nor will you be able to
perform any other actions on a changed area, such as rescanning a zone,
repositioning a pasted area, or editing added text.

Click Yes in the message box when prompted.
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Adding and replacing pages in an Infoprint Scan
document

The following procedures are applicable only when you are using the Infoprint Scan standard
interface. If it is available with your version of Infoprint Scan and you want to use the alternate
copier interface, refer to "Using the Infoprint Scan Copier interface| on page [119 for information.

There are several ways that you can add new pages and replace existing pages in an Infoprint
Scan document:

e You can scan a new page or pages into the document.
For information, go to "Scanning to add or replace pages' on page 99|

e You can add one or more single-page TIFF (Tagged Image File Format) files to the
document.
For information, go to "Inserting TIFF files!' on page 101

e You can add blank pages to the document.
For information, go to "|nserting blank pages'' on page 106}

Scanning to add or replace pages
To scan a new page or pages into an existing Infoprint Scan document:

1. Open the Infoprint Scan document to which you want to add a page or pages.

2. Place the hardcopy page or pages in the scanner's document feeder. For the Xerox
Doculmage 620S scanner, position the pages face up, inserting the sheets with the short
edges leading. For other scanners, refer to the manufacturer's instructions.

3. Go to the location in the document where you want to insert the page or pages.
See "Navigating through an Infoprint Scan document" on page|115|for assistance.

This is not necessary if you are going to append the page or pages to the end of the
document.

4. Click File in the menu bar and then click Scan....
(A=W Edit Page Y“iew T

[HEw .. (7l
Eem.. [+
Cloze

s
Bemove. .
Expart...
Submit Job... Chl+d
Frirt.... Chrl+F
E it
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In the Original area of the Append Scan document dialog box, select:

¢ One-sided - if the hardcopy is printed on just the front side of the paper.

o Two-sided - if the hardcopy is printed on both the front and back sides of the paper.
See "Scanning Two-Sided Originals'' on page 113|for additional information about
scanning two-sided originals.

Append Scan Document |

= TwoSided  Change Settings |

— Oniginal

[ Landscape

fode; Black and“white
Reszalution :  B00 dpi
Original Size : | etter - 8.5 % 11 in

[T Custom Page size I " I inches

— Location

% append to end of curent docurment
™ |nzert before cument page
i~ Ingert after curent page

" Feplace curent page

Scan I Cloze L\\(J

Check the Landscape check box only if you want to rotate the output image 90 degrees
clockwise.

Click the Change Settings button to view or change the scanner settings.
The Mode, Resolution and Original Size fields cannot be edited in the Zone Scan Settings
dialog box. These fields reflect the options you select for scanner settings.

(Refer to "Setting up the scanner’" on page (13 for detailed information about scanner
settings.)

If your original hardcopy document has a page size that is not listed among the scanner
settings options, check the Custom Page size check box and enter the dimensions in the
fields provided.

In the Location area, select one of the following:

e Append to end of current document - to add the scanned page(s) at the end of the
document that is currently displayed. The last added page will become the last page of
the document.

o Insert before current page - to add the scanned page(s) in front of the page that is
currently displayed.

o Insert after current page - to add the scanned page(s) in back of the page that is
currently displayed.

¢ Replace current page - to insert the scanned page(s) at the same location in the
document as the page that is currently displayed, and delete the current page. For
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multiple pages, the first scanned page will replace the current page and any subsequent
pages will then be added behind it.

Note: When you use the Insert before current page, Insert after current page, and
Replace current page options, keep in mind that when you insert a page, the new
page becomes the current page. If you add additional pages, depending on which
option you select, the next page scanned will be inserted before, after, or will replace
the last page scanned.

10. Click the Scan button.

11. When scanning has completed, if you want to scan another page or pages to add to specified
locations in the document, place your hardcopy page(s) on the scanner, and repeat these
instructions, beginning with step 3.

12. When you have finished scanning all of the pages you want to add at this time, click the
Close button to return to the open document.

13. When you have finished with the open document:
e Click File in the menu bar, and then click Close to close and save the open document.
or
e Click File in the menu bar, and then click Exit to close and save the document and exit
the Infoprint Scan program.

Inserting TIFF files

Use this procedure when you want to insert previously scanned files or TIFF files created with
programs other than Infoprint Scan. You can add existing TIFF files selectively, or you can add all
of the files contained in a particular directory.

Note: If any of the files that you want to insert are read-only, keep in mind that you will not be

able to use any Infoprint Scan functions that would result in a modification to the read-only files

(such as, image enhancement, page alignment, adding text, or any other editing). If you need to
use these functions on the files or on the Infoprint Scan document that will include the files, first
change the files to read/write, or create and insert read/write copies of the original files.

To insert one or more TIFF files into an Infoprint Scan document:
1. Open the Infoprint Scan document into which the TIFF file(s) will be inserted.

2. Go to the location in the document where you want to insert the file(s).
See "Navigating through an Infoprint Scan document" on page |115/for assistance.

3. Click Page in the menu bar, and then click Add....

(LN Wiew  Tools

"
Save Az

Delete
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4. To add one or more files selectively:
Click the Add File button in the File Selection area of the Add Page dialog box.

102

a.

Add Page B3
— Location

" Append to end of curment document

™ |mzert before curent page

¢ |nzert after current page |

" Replace cument page

 File Selection

Add Directary. .

add File.,

Efemove

s

Inzert Blank

[ome

Cancel Help |

In the Open TIFF Files dialog box, locate the appropriate directory and highlight the file(s)

you want to insert.

See "Selecting multiple files! on page [114 for information about selecting multiple files.

Click the Open button.

Open TIFF File

Lookin: | =3 Scan suf

HEfSl ) B

M tester_1_000G b
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testit_1_0007 tif
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K8 | | |
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The highlighted file(s) will be added to the list box in the Add Page dialog box.
See "Using the Add Page list box! on page 114 for information about using the list box.

ChScan\Scan stuffyeestit_1_ 0007 G
C:AScan\Scan stuffskester_1_0005_tif
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5. To add all of the files in a directory:
a. Click the Add Directory button in the File Selection area of the Add Page dialog box.

Add Page

— Location

" Append to end of curent document

" Ingert before curment page

% |nzert after cunent page

" Replace cument page

— File Selection

Add Directory.

Add File. ..

b i

Eemowe

Inzert Blank

gl

[ane Cancel Help

b. Inthe Open Directory to Add Files From dialog box, select the directory that contains the
files you want to insert.

c. Click the Open button.

Open directory to add hles

Lok ir: I | m

Canicel |

The files contained in the highlighted directory will be added to the list box in the Add
Page dialog box. If necessary, you can reorder the files or selectively remove individual
files from the list.

See "Using the Add Page list box! on page 114 for information about using the list box.
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6. Inthe Add Page dialog box, select one of the following:

Append to end of current document - to add the TIFF file(s) at the end of the
document that is currently displayed. The last added file will become the last page of the
document. Multiple files will be processed in the order in which they appear in the list box,
that is, from the top down.

Insert before current page - to add the TIFF file(s) in front of the page that is currently
displayed. Multiple files in the list box will be processed in reverse order, so that the files
are added one in front of the other, from the bottom of the list to the top of the list.

Insert after current page - to add the TIFF file(s) in back of the page that is currently
displayed. Multiple files will be processed in the order in which they appear in the list box,
that is, from the top down.

Replace current page - to insert the TIFF file(s) at the same location in the document as
the page that is currently displayed, and delete the current page. For multiple files, the
first file in the list will replace the current page and any subsequent files in the list will
then be inserted after the current page.

Add Page Ei

— Location

™ Append to end of curent document
" Ingert before cument page
% Ingert after cument page

" Replace curment page

— File Selection

ChScan\Scan stuffnexttest 10031 G ;I Add Directary...
C:AScan\Scan stuffskester_1_0001 tif
ChSecan\Scan stuffstester 10002 Add File
CA\Scan\Scan stuffutester_1_D003 L
ChSecan\Scan stuffitester 10004,
CA\Scan\Scan stuffytester_1_D005 L
ChSecan\Scan stuffitester_1_000E
CAScan\Scan stuffytester_1_0008 L
ChScan\Scan stuffseestit_ 10007 G
CAScanhScan stuffyeestt_1_ 00034
ChScan\Scan stuffseestit_ 10004, 4
CAScanhScan stuffyeestt_1_ 0005, 4
CAScan\Scan stuffstestzize 100071 tf

CAScan\Scan stuffstestzize_1_0002 tF
C:AScanhScan stuffuntitled_1_0003.kf = Insert Blank |

Dane l}J Cancel Help |

<l u

Note: When you use the Insert before current page, Insert after current page, and

Replace current page options, keep in mind that when you insert a page, the new
page becomes the current page. If you add additional pages, depending on which
option you select, the next page scanned will be inserted before, after, or will replace
the last page scanned.

7. When you have finished with the open document:

Click File in the menu bar, and then click Close to close and save the open document.
or

Click File in the menu bar, and then click Exit to close and save the document and exit
the Infoprint Scan program.
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Inserting blank pages

To insert a blank page or pages into an Infoprint Scan document:

1.
2.

106

Open the Infoprint Scan document into which the blank page(s) will be inserted.

Go to the location in the document where you want to insert the blank page(s).
See "Navigating through an Infoprint Scan document" on page 115 for assistance.

Click Page in the menu bar, and then click Add....

[RECEN Wiew  Tools

M
Save bz

Delete
Click the Insert Blank button in the File Selection area of the Add Page dialog box. The
name of a new file containing a blank page will be added to the list box in the Add Page
dialog box.

Add Page E3
— Location

% Append to end of current document
" Ingert before cument page

" Ingert after cument page

" Replace curment page

— File Selection

ChSecan\Scan stuffZoneSamp 10015, Add Direchary...
CAScan\Scan stuff?oneSamp_1_0016 tif

Add File...

<l u

Ingert Blank EI

Dane Cancel Help |

To add multiple blank pages, click the Insert Blank button again for each blank page you
want to add.
See "Using the Add Page list box" on page 114/ for information about using the list box.

In the Add Page dialog box, select one of the following:

e Append to end of current document - to add the blank page(s) at the end of the
document that is currently displayed. The last added page will become the last page of
the document.
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o Insert before current page - to add the blank page(s) in front of the page that is
currently displayed.

+ Insert after current page - to add the blank page(s) in back of the page that is currently
displayed.

¢ Replace current page - to insert the blank page(s) at the same location in the document
as the page that is currently displayed, and delete the current page.

Note: When you use the Insert before current page, Insert after current page, and
Replace current page options, keep in mind that when you insert a blank page, the
new blank page becomes the current page. If you add additional pages, depending on
which option you select, the next page added will be inserted before, after, or will
replace the last page added.

In the Add Page dialog box, click the Done button to add the blank pages and return to the
open document.

7.  When you have finished with the open document:
o Click File in the menu bar, and then click Close to close and save the open document.
or
e Click File in the menu bar, and then click Exit to close and save the document and exit
the Infoprint Scan program.
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Removing or deleting Infoprint Scan documents and
pages
The following procedures are applicable only when you are using the Infoprint Scan standard

interface. If it is available with your version of Infoprint Scan and you want to use the alternate
copier interface, refer to "Using the Infoprint Scan Copier interface| on page [119 for information.

The following procedures explain how you can:
o "Remove or delete Infoprint Scan documents' (see page 109)

¢ "Remove or delete pages from Infoprint Scan documents” (see page (110)

Remove or delete Infoprint Scan documents

Note: This function is not available when Infoprint Scan is invoked from within the Infoprint
Submit program.

To remove or delete an entire Infoprint Scan document:
1. Open the Infoprint Scan document that you want to delete.
2. Click File in the menu bar, and then click Remove....

(Z=8 Edit Page “iew T

Iew . [Etr{+H
pem... [EEr{+
Cloze

Scan...

MI
Expart...

Submit Job... Chll
Frirt.... Chrl+F

Exit

3. Inthe Delete/Remove Pages dialog box, select the Document radio button.

Delete/Remove Pages |

i~ Cument Page
" Range From; I o I

Hemwel Delete | Cancel | Help
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You can then select to Remove or to Delete the document. The difference between the two
is as follows:

o If you select Remove, the job ticket for the document will be deleted, but the document
and its associated TIFF files will be retained on your disk.

o If you select Delete, the job ticket for the document, the document, and all associated
TIFF files will be totally deleted from your system.
To proceed, click:

a. The Remove button to remove the job ticket, but retain the document files.
or

b. The Delete button to totally delete the document files.

Click File in the menu bar, and then click Exit to close the Infoprint Scan program.

Remove or delete pages from Infoprint Scan documents

You can remove specified pages from an Infoprint Scan document using the Remove option in
either the File menu or the Page menu.

When you use the Delete option in the Page menu, you can remove a single page from the
document without deleting the associated TIFF file.

To find out how to remove a single page in this manner, go to "Remove the current page' on
page 110.

When you use the Remove option in the File menu, you can remove a single page, or specify
a range of pages to be removed from the document. You can also specify whether to keep
the associated TIFF file(s), or to delete the TIFF file(s) from your system.

To find out how to remove a page or range of pages in this manner, go to "Remove or delete
selected pages/' on page 111.

Remove the current page

You can use the Delete option in the Page menu to remove the currently displayed page of a
Scan document.

Note: The page will be removed from the document, but the associated TIFF file will not be
deleted from your system.

To remove a page from a document:

1.

Open the Infoprint Scan document that contains the page or pages that you want to delete.

2. Go to the page in the document that you want to delete.

110

See "Navigating through an Infoprint Scan document" on page |115/for assistance.
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3. Click Page in the menu bar, and then click Delete.

[&E0EN Wiew  Tools
Add..

Save bs...

_Dakle)y ]
Save

Add Zone
Zane Sethings
Hemoye Zone
Heseaty,.

4. When you are finished, click File in the menu bar, and then click Close to close and save the
open document, or Exit to close and save the document and exit the Infoprint Scan program.

Remove or delete selected pages

You can use the Remove option in the File menu to remove a single page or to specify a range of
pages to be removed from the document. You can also specify whether to keep the associated
TIFF file(s), or to delete the TIFF file(s) from your system.

To remove or delete selected pages:

1. Open the Infoprint Scan document that contains the page or pages that you want to remove
or delete.

2. Click File in the menu bar, and then click Remove....
(H-8 Edit Page “iew T

e [l
[Eer... [l
Cloze

Scan...

MI
Export...

Submit Job... Chrl+
Frint.... Chrl+F

E xit
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In the Delete/Remove Pages dialog box, select:

e Current Page - to remove or delete the page that is currently displayed.
or
e Range From __to__ - to remove or delete a range of pages.
Type the number of the first and last pages of the page range in the fields provided.

Delete/Remove Pages |

" Cument Page

= Fange From: IE ta I'Il:i

™ Document

Hemwel Delete | Cancel | Help |

You can then select to Remove or to Delete the page or pages.

o If you select Remove, the page(s) will be removed from the document, but the
associated TIFF file(s) will be retained on your disk.

e If you select Delete, the page(s) will be removed from the document, and the associated
TIFF file(s) will be deleted from your system.

To proceed, click:

o The Remove button to remove the page or pages, but retain the TIFF file(s).
or

e The Delete button to remove the page or pages from the document, and delete the TIFF
file(s).

When you are finished:

e Click File in the menu bar, and then click Close to close and save the open document.
or

e Click File in the menu bar, and then click Exit to close and save the document and exit
the Infoprint Scan program.
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Hints and tips for using Infoprint Scan

The following are a few things that are good to know and will assist you when you are using the
Infoprint Scan standard interface. If it is available with your version of Infoprint Scan and you want
to use the alternate copier interface, refer to "Using the Infoprint Scan Copier interface’' on page
119 for information.

Copy changes vs Copy button

Do not confuse the Copy changes button with the Copy button, as they are very similar:

e The Copy changes button is located on the left side of the tool bar, within the first group of
tools.

e The Copy button is located on the right side of the tool bar, within the last group of tools.

X |G| ®

Copy

Scanning Two-Sided Originals

e If you are using a simplex scanner, and you select Two-sided in the Original area, after the
front side has completed scanning, you will be prompted to turn over the original hardcopy on
the scanner so the back side can be scanned. When you are prompted:

1. Click the OK button in the prompt window.

InfoPrint Scan |

Scanning the Back zide of the Docurment now.
Please tum the stack over and press the 'O button.

Caricel |

2. Turn over the original hardcopy in the scanner's document feeder.

3. Click the Scan button again to begin scanning the back side.

e If you are using a duplex scanner, and you select Two-sided in the Original area:

— If your original hardcopy has a standard, predefined paper size (such as, Letter or A4),
the pages will be turned as they are scanned.

— If you have defined a custom paper size, after the front side has completed scanning, you
will be prompted to turn over the original hardcopy on the scanner so the back side can
be scanned. When you are prompted:

1. Click the OK button in the prompt window.
2. Turn over the original hardcopy in the scanner's document feeder.
3. Click the Scan button again to begin scanning the back side.

© Copyright IBM Corp. 1999 113



Selecting multiple files

When you use Infoprint Scan on a Windows system, as with all Windows applications, Infoprint
Scan does not necessarily process files in the order in which you select them in the Open dialog
box.

o If you use the mouse or click-shift-click to select multiple files, the last file is processed first
and the first file is processed last. All other files are processed in the order of selection. For
example, if you select FILE1, FILE2, FILE3, and FILE4 in that order, the processing order is
FILE4, FILE2, FILES3, FILE1.

e If you use the Ctrl key on the keyboard to select multiple files, files are processed in reverse
selection order. For example, if you select FILE1, FILE2, FILE3, and FILE4 in that order, the
processing order is FILE4, FILE3, FILE2, FILE1.

e After selection, you can reorder files in the selection list until they appear in the order in which
you want them to process, as described in "Using the Add Page list box" on page [114.

Using the Add Page list box

You can add pages to an Infoprint Scan document as instructed in "Adding and replacing pages
in an Infoprint Scan document" on page 99. The following are a couple of tips that may assist
you once you have selected and added the pages to the Add Page list box:

e Toremove a file from the list, highlight the file and click the Remove button.
e To reorder the files in the list, highlight a file and click the up arrow or the down arrow.

Add Page

— Location

€ Append to end of curent document
" Ingert before curment page
% |ngert after cument pags

" Replace curment page

— File Selection

CAScansScan stuffnew, jtk, ;I Add Directary...
CAScansScan stuffsnew 10007 v
CAScansScan stuffnews_1_0002 b

|C\ScantScan shuffyiew 10003t aolies
i 5

ansacan stuffsnews 7 0004 b
S canhScan stuffnews 10006, L

C:AScansScan stuffnews_1_0008, t

C:AScanyScan stuffnews 10009, L

C:AScansScan stuffnestiest jtk,

C:AScanyScan stuffnestiest 10007 tF

C:AScansScan stuffsnesttest_1_D002

C:AScanScan stuffnestiest 10003 tF

C:AScansScan stuffnesttest_1_D005

C:AScanScan stuffnestiest 10006t

C:AScanyScan stuffiresttest_1_0071 tf =1 | seietet

Remaove

e bl

Done I Cancel | Help |
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Navigating through an Infoprint Scan document

You can navigate, or page through an Infoprint Scan document using either the options in the
View menu or the buttons in the tool bar.

Navigate through a document using View menu options

Click View in the menu bar, then select from the following options:

Next Page - displays the page following the current page of the document.
Previous Page - displays the page before the current page of the document.
First Page - displays the first page of the document.

Last Page - displays the last page of the document.

Go to Page... - lets you specify a particular page to display.

Toolz: Optionz  Help

Scale... »
Prewiouz Page ! Follp
First Page Home
Laszt Page End

Go ToPage.. Chrl+3
Dizplay R eference b ark

Navigate through a document using the buttons in the tool bar

The following navigation tools are provided in the tool bar:

H First page - goes to the first page of the document.

ﬂ Previous page - goes to the page immediately preceding the current page.
ﬂ Next page - goes to the page immediately following the current page.

ﬂ Last page - goes to the last page of the document.

Zooming on pages in an Infoprint Scan document

You can increase or decrease the magnification of the displayed page in an Infoprint Scan
document using the Zoom button in the tool bar:

Click the Zoom in View button g to display the zoom tool ™.
Position the zoom tool where you want to zoom on the page.

To zoom:

e Click the left mouse button to zoom in on the page. The magnification of the page is
increased by one level each time you click the left mouse button.

¢ Click the right mouse button to zoom out on the page. The magnification of the page is
decreased by one level each time you click the right mouse button.

4. To deselect the Zoom tool, click the Pointer tool El
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Optimizing halftone scanning for printing as grayscale

When you scan pages that contain a combination of text and halftone image data you will need to
zone and rescan the portions of the pages that contain the halftone images as grayscale. You'l
achieve the best output results by combining some of the procedures for scanning, zoning, and
working with layers that were described in previous sections.

Note: The scanner settings described in this procedure are those used by Xerox Doculmage

620S scanner driver.

To improve the output appearance of scanned halftones:

1. Scan the entire page first as a Black and White image.

a.

If this is a new document, follow the basic procedures in "Scan a new Infoprint Scan
document/' on page 3.

or

If you're adding a page to an existing document, follow the basic procedures in "Scanning
to add or replace pages' on page 99.

During the scanning process, you'll access the Scanner Settings dialog box by clicking
Change Settings in the Scan Document or Append Scan Document dialog box.

Append Scan Document

! Change Seftings |

In the Scanner Settings dialog box:
o Be sure to select Black and White in the Mode field.
o Be sure to select 600 in the Dots per inch field.

Scanner Settings

Mode:
[Black and White =
Dither:

| Fine Halftone ﬂl
Dots per inch:

iod 7]
200

300
400

1200 g

o Set other scanning options as applicable, as described in "Understanding and using
the available scanner settings” on page 15,

¢ Click OK when you are finished selecting scanning options.

Original
" OneSided

[T Landscape

When you have finished setting all scanning options, click Scan in the Scan Document or
Append Scan Document dialog box to scan the document or page.

2. If required, set and execute enhancement options for the document or page as described in
"Enhancing images in an Infoprint Scan document" on page|25. All image enhancement
should be done to the black and white scanned images, before you rescan the page as
grayscale.

116
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3. Ifitis not currently displayed, use the buttons on the tool bar or the available options in the
View menu to display the page that contains the area you want to scan as grayscale. (See
"Navigating through an Infoprint Scan document" on page 115 for information.)

4. Define the area of the page that contains the image you want to scan as grayscale, as
described in "Zoning pages in an Infoprint Scan document' on page 55|

& InfoPnint Scan - [ZoneSamp.jtk : Page 3 of 4]

File Edit Page “iew Toolz Optiohs Help

el glalsa] alalk|e|= ¢ s|alxo|z] wlel] 4] mxals |

Communications soluti ons for
your business needs

'With B Person sl Syater ==
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a. During the zoning process, you'll access the Scanner Settings dialog box by clicking
Change Settings in the zone Scan Settings dialog box.

Zone Scan Setings |

— Ophions
Change Settings
b ode:; GrayScale - 256 levels

Original Size : Letter - 3.5 % 17 inches
Rezolution : 200 dpi

k. Cancel Reszcan

b. Inthe Scanner Settings dialog box:
e Be sure to select 256-Level Gray in the Mode field.
o Be sure to select 400 in the Dots per inch field.
e Click OK.

c. Inthe Zone Scan Settings dialog box, click Rescan to scan just the defined area with the
new settings.
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5. After the page has finished rescanning:

e (Click the Undo Zone button Igl in the tool bar.
or

e Click Page in the menu bar, and then click Remove Zone.

[SCLCN Wiew  Tools

Add Zone
Zone Sethings

e

EICAN...

6. Click on to select the defined area.

7.

9.
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Click Edit in the menu bar, and then click Descreen Layer to remove the existing halftone
screen from the image.

Repeat these procedures for all halftone image areas on the current or other pages of the
document.

When you have finished rescanning and descreening all halftone image areas, output the
document in one of the ways described in "Printing Infoprint Scan documents" on page 39,

Note: You do not need to apply a new screen now in order to print the image. If you are
printing on the Infoprint 2000, the appropriate screen will be added at the printer. If
you have Infoprint Manager installed and you send the job to the Infoprint server to be
queued for printing, the appropriate screen will be added at the server.

When you are done:

e Click File in the menu bar, and then click Close to close and save the open document.
or

Click File in the menu bar, and then click Exit to close and save the document and exit
the Infoprint Scan program.
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Using the Infoprint Scan Copier interface

Infoprint Scan provides an alternative interface that you can use for scanning and printing
hardcopy documents. This is a simplified version of the Infoprint Scan standard program that
includes a copier-like interface that is designed for use with a touch screen monitor. If you do not
have a touch screen monitor, you can still use a mouse to select options and perform scanning
and printing operations.

The copier interface provides a subset of the functions that are available in the Infoprint Scan
standard interface. You can set options for paper size, sides for scanning and printing, and
specify the image type of the hardcopy original document. Enhancement options include image
shift, edge erase, page numbering, and booklet making. For finishing, you can select which
output stacker to use on the selected printer, specify stapling options, and turn edge trimming on
or off for booklets. For small documents (those that comprise 50 or fewer sheets of paper), you
can scan and print with one push of a button. You can use either the copier interface or the
standard interface; both are provided with Infoprint Scan. If you require more advanced
capabilities for setting up your scanner and printer and for image enhancement than are available
in the copier interface, then you should use the standard interface.

Note: If the workstation where Infoprint Scan is installed has a touch screen monitor, general
user operations in the copier interface may be done using touch only, though, if you prefer, you
do have the option of using a mouse. The administrative tasks of switching to the standard
interface, specifying scanner settings, and exiting the copier interface, can only be done using a
mouse and keyboard.

The following topics provide information about the Infoprint Scan copier interface:

e "Starting the Infoprint Scan copier interface' on page|121- describes how to open the copier
interface.

e "Scanning and printing" on page 123 - describes how to use the functions of the copier
interface to scan and print a document.

e "Specifying copier settings' on page|132 - describes how to specify default settings for the
copier interface.

e "Recovering from a paper jam" on page|137| - describes what to do to resume scanning after
a paper jam.

Important: Be sure to read the following tips - they include helpful information for using the
Infoprint Scan copier interface.

Tips:

e The Infoprint Scan copier interface uses the entire display area of your screen. If the
Windows taskbar is visible at the bottom or side of the display area, it can interfere with the
display of the copier interface. Before you start the Infoprint Scan copier interface, you need
to hide the taskbar:

1. Position the mouse cursor in a blank area of the taskbar and click the right mouse button.

| garntoPintsean | Iy BTy 354 aM
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2. Click Properties with the left mouse button.

[Eazcade
Tile Homzortally
Tiletterteal

= o e

| tsinopintsean | D) 5%

3. Inthe Taskbar Properties dialog box, check the Auto hide checkbox.

Tazkbar Properties EHE

Taskbar Dptions | Start Menu F'ru:ugramsl

[ N
Sound Re

“Wwordpac

[ Show small icons in Start menu

v Show Clock

0k I Cancel Apply

4. Click the OK button.

Help for using the Infoprint Scan copier interface is displayed at all times in the lower right
area of the interface.

When you are using the Infoprint Scan copier interface, and are loading paper into the Xerox
Doculmage 620S scanner's multi-sheet document feeder, position the pages face up. For
8.5" x 11" paper, insert the sheet with the long (bind) edge leading.

;R

e =
i—

For all other paper sizes, insert the sheet with the short edge leading.

Note: Keep in mind that when you use the Xerox Doculmage 620S scanner with the Infoprint
Scan standard interface, you should always insert the sheets face up with the short
edge leading for all paper sizes. For other scanners, refer to the manufacturer's
instructions.
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e For security purposes, the scanned pages are not saved on your system after the scanning
and printing process is completed for a document.

o When the Infoprint Scan copier interface is active, click the right mouse button and then click
Advanced with the left mouse button to switch to the standard interface.

Settingz ! |

E st

e To close the Infoprint Scan program from the copier interface:
— Click the right mouse button and then click Exit with the left mouse button.

Advanced
Settingz

or
— Press the Alt+F4 keys on the keyboard.

Starting the Infoprint Scan copier interface
You can start the copier interface from an open Infoprint Scan standard interface session, or you

can specify to start the copier interface first when Infoprint Scan is started.
Starting the copier interface from the standard interface
Note: The first time you use the copier interface, you must start it from the standard interface.

To start the copier interface from the standard interface:
1. Start Infoprint Scan.
2. In the standard interface main window, click Options in the menu bar, and then click Copier.

=

Erhance Settings ...

Server Settings...

Preferences...
Refresh

Select ST anmer. .
Copier Settings... !
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Note: You cannot access the copier interface if there is an open document displayed in
the standard interface. If a document is open, be sure to close the document before

continuing. To close an open document in the Infoprint Scan standard interface, click File
in the menu bar, and then click Close.

& InfoPrint Scan - [untitled_jtk: Pag

JI{C Edit Page “Wiew Toolz Option:
L5 [Bir| el
=iy (Bt e &

Scan...

Bemove...
Edar
Export...

[Tl L

Submitdob.. Chlal [ et

I ma<e 1ha Spoa

o def ming yoLr
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Exit Foe iFe Tires 50 p
T il BNe Jreen neac

Starting the copier interface first when Infoprint Scan is started

You may want Infoprint Scan to start the copier interface first if it is the primary Infoprint Scan
interface that you will be using.

To open the copier interface first when Infoprint Scan is started:

1. Start the Infoprint Scan standard interface, then click Options in the menu bar, and then click
Copier Settings....

Enhance Settingz ...
Server Seftings. .
Preferences. .
Refresh

Select Scannen..
Copier

Copier Settings...
or

From the Infoprint Scan copier interface, click the right mouse button and then click
Settings with the left mouse button.

Advanced

E st

2. Inthe Copier Settings dialog box, select the On radio button for Copier Autostart.
(To start Infoprint Scan with the standard interface, select the Off radio button.)
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Copier Settings |

Printer I Irfopriet 2000 j Printer Features

Fleset Tineout Of 1 51015 30 45 60 (ke
itz Lot Eookletmaker
|
Copier Autoztart i Elr's i
Options Edge Erase kargin

O] Deskew IU-25 inches

[ Offset stackin
d Bind Eraze Margin

IEI.E— inches

Supported Papers Favorite 3 Papers
i3 - > |
A3Color beld >
A3lnzert

ﬂ <-- Remove |

Ad
k. | Cancel I Help

3. Click the OK button to save this setting and close the dialog box.

Note: This and any other modified settings will take effect the next time you start Infoprint
Scan, restart the copier interface, or click the Reset button on the copier interface.

©

For information about setting other options for the Infoprint Scan copier interface, refer to
"Specifying copier settings'' on page 132.

Scanning and printing

When you are ready to scan a hardcopy document using the Infoprint Scan copier interface, the
first thing you need to do is determine whether you have a large job or a small job. You make this
determination based on how many sheets of paper will fit in the document feeder of your scanner.
The document feeder of the Xerox Doculmage 620S scanner will hold approximately 50 sheets of
paper at one time. So, when you are using the Xerox Doculmage 620S scanner:

e Asmalljobis a hardcopy original document that consists of up to 50 sheets of paper. The
entire original document can be placed in the document feeder and can be scanned and
printed in one step. Refer to "Scanning and printing a small job! on page (124 for
information.

e Alarge job is a hardcopy original document that consists of 50 or more sheets of paper.
The document must first be scanned in separate stacks of up to 50 sheets, until all of the
pages have been scanned, and then the entire document can be printed at one time.
Refer to "Scanning and printing a large job! on page 125 for information.
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Scanning and printing a small job

Note: When you follow the instructions for a small job, your document will be scanned and
printed in one step. If you want to view the scanned document online, run a proof print, and make
any additional modifications to the scanned document before final printing, you can follow the
instructions in "Scanning and printing a large job" on page [125, even if your document comprises
fewer than 50 sheets of paper.

To scan and print a small job:

1. Place the hardcopy original document in the scanner's multi-sheet document feeder. Position
the pages face up. For 8.5" x 11" paper, insert the sheet with the long (bind) edge leading.
For all other paper sizes, insert the sheet with the short edge leading.

SMALL

3. Use the numeric keypad to specify the number of copies you want to print.

000
000
Q00
©0@

Tip: Press the Clear (C) key to reset the number of copies to 1.

4. Press each of the tabs in the notebook section of the interface to set options for Setup,
Finish| and Enhance|

S W

Go to "Specifying Setup, Finish, and Enhance options'' on page 127 for information about
each of the options you can set.
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Press to scan and print the document.

Note: If a paper jam occurs while you are scanning the document, go to "Recovering from a
oaper jam[' on page (137 for instructions.

When the document has finished printing:

a. Select if you want to view, modify, proof, and reprint the current job,
then continue with step 3/of "Scanning and printing a large job" on page 125

or

b. Press @ to clear the viewport and return all settings to their original values.

Scanning and printing a large job

To scan and print a large job:

1.

Place the first 50 sheets of paper in the scanner's multi-sheet document feeder. Position the
pages face up. For 8.5" x 11" paper, insert the sheet with the long (bind) edge leading. For
all other paper sizes, insert the sheet with the short edge leading.

Press to scan the first 50 sheets.

Place the next 50 sheets in the scanner's multi-sheet document feeder.

Repeat steps 3 and 4, as necessary, until all of the pages of the hardcopy original document
are scanned.

Note: If a paper jam occurs while you are scanning the document, go to "Recovering from a
oaper jam[' on page (137 for instructions.

Press each of the tabs in the notebook section of the interface to set options for Setup,
Finish, and Enhance.

«e | MR SR
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Go to "Specifying Setup, Finish, and Enhance options'' on page 127 for information about
each of the options you can set.

The last page scanned will be displayed in the viewport.

o Use the buttons below the viewport to page through and check the scanned document,
and, if required, to add or delete pages. These buttons are described in "Using the
viewport buttons' on page 138.

e If necessary, repeat step 6 to make further modifications.

Press -II il 0 print a single proof copy of all scanned pages.

If necessary, repeat step 6 to make further modifications.

Use the numeric keypad to specify the final number of copies you want to print.

000
000
Q00
©0@

Tip: Press the Clear (C) key to reset the number of copies to 1.

== I.E}.!

=117

10. Press sk 1o print the final copies of the document.

11. When the document has finished printing:

a. Select again to view, modify, proof, and reprint the current job.

or

b. Press @ to clear the viewport and return all settings to their original values.
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Specifying Setup, Finish, and Enhance options

Press each of the tabs in the notebook area of the Infoprint Scan copier interface to set options
for Setup, Finish| and Enhance!

SETUP \

Use Setup to specify information about the document that you are going to scan and print.
1. Paper size - press the size that matches the input and output size of the document.

Letter Ledger
85X 11in 11 X17in
Legal

85X 14 in LI

If the corresponding size is not displayed, press More..., then highlight the appropriate
paper size and press OK.

A329T x 420 mm
A3Color, 297 x 420 mm
Adinsert, 297 x 420 mm

A4 210 x 297 mm
AdColor, 210 x 287 mm
AdCover, 210 x 297 mm
{AdInsert, 210 x 297 mm
AdTab, 225 x 287 mm
AdTrans, 210 x 287 mm
Color85x11in
Cover,8B5x11in
Insert85x 11 in
LagalB5x 14 in
Letter,85x 11in
Tab9x11in
Tabloid, 11 x 17 in
TabloidColor, 11 x 17 in
{Tabloidinsert, 11 x 17 in
Trans,85x 11 in

The selected paper size will now be displayed on the interface.

Letter Ledger
85X 11in 11X 17in
Legal Ad

85X 14in 210 x 297 mm
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2. Sides - press to cycle through your options and select how the input document is printed,
and how the scanned output will be printed:

1+1

Select if the original hardcopy is printed simplex (1-sided), and the scanned
output will be printed simplex.

142

Select if the original hardcopy is printed simplex, and the scanned output
will be printed duplex (2-sided).

21

Select if the original hardcopy is printed duplex, and the scanned output will
be printed simplex.

222

Select if the original hardcopy is printed duplex, and the scanned output will
be printed duplex.

3. Image type - Press to specify the composition of your original hardcopy document. This
will optimize the scanning process for the input data.

Select if your input document is composed primarily of a combination of text and
graphics.

Select if your input document is composed primarily of text only.

Use Finish to specify what finishing options you want to apply to the scanned document
when it is printed.

1. Stacker - Use this to specify the location on the printer where you want to send the
printed output. A graphic of your printer and its available output bins is displayed. Only
those output bins specified for your printer in step 5 of "Specifying copier settings" on
page 133 are available.

Press on the area of the graphic that corresponds to the output bin you want to use. The
selected output location will be highlighted with a green outline.
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Staples - This is only available when you select a printer output bin that supports
stapling. Press to select a stapling option. For example, the following options are
available for the Infoprint 2000 stapler:

Select if you do not want the printed output to be stapled.

e

=== Select to put one staple in the upper left (bind) margin.

1
st Select to put one staple in the lower left (bind) margin.

(This is most often used when the document has a horizontal, or landscape
orientation.)

Select to put two staples, one in the upper left and one in the lower left margin.

Edge trim - This is only available when you select the Infoprint 2000's booklet maker for
the output location. Press to specify whether you want to trim the edges of printed
booklets. If you select to turn edge trimming on, the edges will be trimmed by the amount
previously set on the booklet maker itself.

Select to turn edge trimming Off.

Select to turn edge trimming On.

Use Enhance to specify options to improve the appearance of your scanned document. you
want to apply to the scanned document when it is printed.

1.

Image shift - Use this to shift the page image a specified increment to the right to allow
for a wider margin for binding or hole punching. For duplex printing, this function will
adjust back pages to shift to the left the same amount as the front pages. Press to select
the amount to shift the page image:

Select if you do not want to shift the page image.
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Select to shift the page image 1/5 inch.

Select to shift the page image 2/5 inch.

Select to shift the page image 3/5 inch.

Select to shift the page image 4/5 inch.

Select to shift the page image 1 inch.

2. Edge erase - This will eliminate an unwanted black border, marks, specks, or other data
from around the page margins. An example of such unwanted data is the "shadows" that
may be left when you scan three-hole punched pages. The width of the area that will be
erased around the edges is specified in step [7|of "Specifying copier settings" on page
134. Press to select the edge erase option you want to use:

Select if you do not want to activate the edge erase function.

Select to erase the data evenly around all four edges.

Select to erase the data around all edges, adjusting for a wider margin on the
bind edge. The back page is adjusted for duplex printing.
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3. Page numbering - This will add page numbers to a specified position at the bottom of
each page of the scanned document. Press to select the position of the page numbers:

Select if you do not want page numbers added to the scanned pages.

~aT

sl Select to add a page number at the bottom, left side of each page. The position
of the page number is adjusted on the back pages for duplex printing.

¥
S=== Selectto add a page number at the bottom, center of each page.

*
===dSelect to add a page number at the bottom, right side of each page. The position
of the page number is adjusted on the back pages for duplex printing.

4. Booklet layout - Use this to print your scanned pages 2-up. With this function, two pages
print side-by-side on each side of a physical sheet of paper, ordered appropriately so that
the output can be folded and stapled down the middle. The Infoprint Scan 2000 program
will determine the output paper size by doubling the dimensions of the input paper size
that you selected in the Setup options. Press to select whether you want booklet layout
function turned Off or On:

Select to turn Off the booklet layout function.

Select to turn On the booklet layout function.

Note: The booklet layout function is not automatically tied to an output location on your
selected printer. To have the finished booklet saddle-stitched (stapled on the fold
of the booklet), you must be sure to select the corresponding output location and
stapling options in the Finish tab.
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Specifying copier settings

Use the copier settings to specify the values that will be used as default settings for the Infoprint

Scan copier interface.

Note: Although general user operations in the copier interface may be done by touch if the
workstation where Infoprint Scan is installed has a touch screen monitor, to specify
scanner settings you must always use a mouse and keyboard.

To specify default settings for the Infoprint Scan copier interface:

1. Open the Copier Settings dialog box by doing one of the following:

a. From the Infoprint Scan standard interface, click Options in the menu bar, and then click

Copier Settings....

& InfoPrint Scan

Option: Wl

Enhance Settings ... H
Server Settings...
Preferences. .

Befrezh

Selech SEannern..

Copier

or

Copier Settings...

b. From the Infoprint Scan copier interface, click the right mouse button and then click

Settings with the left mouse button.
Advanced

E wit

2. Inthe Copier Settings dialog box, click the arrow in the Printer field to highlight the printer
type that you will use to output your scanned copies.

Copier Settings |

Frirter | Infoprint 2000

Feszet Timeout
[minutes]

j Printer Features

Stapler

Copier Autoztart

132
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3. Move the Reset Timeout slide bar to specify the number of minutes you want the copier
interface to wait idle before modified settings are automatically reset to their default values.
The default value is Off.

Copier 5ettings |

Printer I Irfopriet 2000 j Printer Features

[minutES] 1 1 1 1 1 1 1 1
i M
S

Copier Autostart " On = 0

If you do not want modified settings to reset automatically, set the slide bar to Off to disable
this function.
4. For Copier Autostart, select one of the radio buttons:

e On - to specify that the copier interface will be started automatically when the Infoprint
Scan program is started.

e Off - to specify that the Infoprint Scan standard interface will be started first when the
Infoprint Scan program is started. To start the copier interface from the standard
interface, click Options in the menu bar, and then click Copier.

Copier Settings |

Printer I Irfoprink 2000 j Printer Features

Reset Tirmeout Off 1 & 10 15 30 45 E0 E‘:E'F'Il'flr

[miHUtES] L‘l I I I ' ' ' ! B ookletmaker
|

Copier Autoztart v Eln O

........

5. Inthe Printer Features list box, highlight the finishing options that are installed on your printer.
The selected options will determine the choices that are available when you select the the
Finish tab on the copier interface. You may highlight one or more, or none of the options. The
default is no finishing options.

Copier Settings |

Printer I Irfopriet 2000 j Printer Features

Reset Timeout OfF 1 510 15 30 45 50 ks

[mritiLikez] 0 o0 o0 o Lot 1 Bookletrmaker
|

Copier Autostart i On o [ff

6. Inthe Options list box, check one or more, or none of the options:

o Deskew - when this is activated (checkbox checked) the program will automatically
deskew all scanned pages. By default, Deskew is not activated.

FYI: Skew occurs when paper goes through the scanner's paper path at a slight angle,
causing the scanned lines to be improperly aligned. Deskew adjusts and corrects the
angle at which a document is skewed, so the page and lines will be aligned properly.
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7.

o Offset Stack - when this is activated, copies of printed jobs will be stacked offset from
each other. Offset stacking is only supported if this feature is also supported for the
output location specified on the printer on the Finish page of the copier interface. By
default, Offset Stack is not activated.

Copier 5ettings |

Printer IInporint 2000 j Printer Features
Freset Timsout Of 1 5 10 15 30 45 &0 ::F'[Lr
[rirwtes) N Lo ! Bookletraker
|
Copier Autostart " On = 0
Optians Edge Eraze Margin

eskew I':'- 25 inches
[ M4

Offzet Stackin
. Bind Eraze Margin

IEI.E— ifches

In the Edge Erase Margin field, type the width of the margin where the black border, black
marks, or black specks around all edges of pages will be eliminated when this function is
activated on the Enhance|page of the copier interface. The range is .01 to 10 inches, with a
default setting of .25 inch.

(See "Changing the unit of measure!' on page 136 to find out how to specify millimeters
instead of inches for the unit of measure.)

In the Bind Erase Margin field, type the width of the margin where the black border, black
marks, or black specks on the bind edge of pages will be eliminated when this function is
activated on the Enhance page of the copier interface. The range is .01 to 10 inches, with a
default setting of .5 inch.

(See "Changing the unit of measure!' on page 136 to find out how to specify millimeters
instead of inches for the unit of measure.)

Copier Settings |

Frinter IInfu:uprint 2000 j Frinter Featuresz
Fleset Timeout Of 1 5 10 15 30 45 60 ik
[ririLikes] ° o0 o o g o o 0
M
_
Copier Autostart i On o Dff
Optiohs Edge Eraze Margin

Deskew IU-45 inches

] Offzet Stackin
. Bind Erase kargin [%

IF inches

9. The Supported Papers list box lists all of the paper sizes/types supported by the workstation's

134

printer driver. Based on their frequency of use, select three of these papers to include in the
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Favorite 3 Papers list box. The papers listed in the Favorite 3 Papers list box will be displayed
for selection on the Setup page of the copier interface. To select your favorite papers:

a. Highlight one of the papers in the Supported Papers list box.

b. Click the Add button.

c. Repeat steps a and b until three papers are listed in the Supported Papers list box.

(To remove a paper from the Supported Papers list box, highlight the paper and click the
Remove button.)

Copier Settings |

Printer IInporint 2000 j Printer Features
o s OfF 1 5 10 15 30 45 0 ::F'l“'[r
[mritiLikez] I 0 o NI 1 Bookletrmaker
I

Copier Autostart i On o O
Options Edge Eraze Maragin
Deskew IU-25 inches
Offzet Stacking _ _

Bind Eraze Margin

IEI.E— inches
Supparted Papers Favorite 3 Papers

Letter
A4Calar 1
A4Cover
Adlnzert j
k. | Cancel Help

10. Click the OK button to save your settings and close the dialog box.

Note: The new settings will take effect the next time you start Infoprint Scan, restart the
copier interface, or click the Reset button on the copier interface.

©)

Tip: Before you save your modified settings, you can click the Cancel button to cancel your
changes and close the dialog box.
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Changing the unit of measure

You can change the unit of measure (from inches to millimeters or from millimeters to inches) for
the edge erase and bind erase margins that you set in the Copier Settings dialog box. You can
only do this from the Infoprint Scan standard interface.

1. Start the Infoprint Scan standard interface.
(If you are currently using the copier interface, click the right mouse button, and then click
Advanced with the left mouse button.)

Settings ! |

E wit

2. Inthe Infoprint Scan standard main window, click Options in the menu bar, and then click
Preferences....

Options WEE
Enhance Settings ...
Server Settings...

MI
Befresh

Selech Scannen..
Copier
Copier Settings...

In the Preferences dialog box, click the Layout tab.

In the Units area, select the either the Millimeters or the Inches radio button.

Preferences |

Frint  Lawout | Scheduls I

Le

L ayout I Ize server default -

Le

Sides I Jse zerver default ~

— Image Fit
& Tiim to finizhed page size

i~ Scale ta finished page zize

= Llr?_i_t_s— Decimal Matation
.M : % se . as delimiter

Inches ™ Usze , az delimiter

k. I Cancel Help

5. Click the OK button.
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6. To return to the Infoprint Scan copier interface, click Options in the menu bar, and then click
Copier.

Enhance Settingz ...
Server Seftings...
Preferences. ..
Refresh

Select Scannen..

Copier Settings... !

Recovering from a paper jam

If a paper jam occurs while you are scanning a document, you should not have to rescan the

entire job. In most cases, the recovery procedure is as follows, depending on whether you are

scanning a small job (up to 50 total sheets of paper) or a large job (more than 50 sheets of

paper).

e If a paper jam occurs while you're scanning a job as described in ''Scanning and printing a
small job" on page [124:

1. Be sure that the last page successfully scanned is currently displayed in the viewport.
(Go to "Using the viewport buttons!" on page 138 for information about paging through the
scanned, displayed document.)

2. Restack all remaining unscanned sheets in their original order in the document feeder.
3. Press to resume scanning.
o If a paper jam occurs while you're scanning a job as described in ''Scanning and printing a

large job" on page 125:

1. Be sure that the last page successfully scanned is currently displayed in the viewport.
(Go to "Using the viewport buttons” on page 138/for information about paging through the
scanned, displayed document.)

2. Restack all remaining unscanned sheets in the current stack of 50 sheets in their original
order in the document feeder.

to resume scanning.
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Using the viewport buttons

e Use the navigation buttons below the viewport to page through and check the scanned
document.

Press to display the first page of the document.
- Press to display the previous page (1 page before the currently displayed page).
Press to specify which page you want to display.

Press to display the next page.

Press to display the last page of the document.
e Use these buttons to add or delete displayed pages:

Press to insert a blank page after the currently displayed page.

m Press to delete the currently displayed page.
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